
LEGAL NOTICES: 
 

TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT SHALL LUMAGEN, ITS SUPPLIERS, OR 
ITS DEALERS, BE HELD LIABLE FOR INJURY TO PERSONS OR PROPERTY, ANY LOST REVENUE, 
LOST PROFIT, SPECIAL, INCIDENTAL, INDIRECT, CONSEQUENCIAL, OR PUNITIVE DAMAGES, 
IMPAIRMENT OF OR DAMAGE TO OTHER GOODS, HOWEVER CAUSED REGARDLESS OF THE 
THEORY OF LIABILITY, RESULTING FROM THE USE OF, OR INABILITY TO USE, THIS PRODUCT, 
EVEN IF LUMAGEN, ITS SUPPLIERS, OR ITS DEALERS, HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.  

LUMAGEN SHALL NOT BE LIABLE FOR OMISSIONS OR ERRORS IN ITS DOCUMENTATION OR 
SOFTWARE. LUMAGEN RESERVES THE RIGHT TO MAKE CHANGES TO ITS PRODUCTS AND 
DOCUMENTATION WITHOUT NOTICE. 

 

Unless you are experienced in the installation and set-up of high-performance video 
electronics, we suggest you hire a professional home-theater specialist to do 
installation and configuration of this product. We recommend that you choose a 
professional who has been certified by the Imaging Science Foundation™  (ISF). 

 

This equipment has been tested and found to comply with the limits for a class B digital device, 
pursuant to Part 15 of the FCC rules, Canadian ICES-003, and CISPR 22. These limits are 
designed to provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the following measures: 

- Reorient or relocate the receiving antenna. 

- Increase the separation between the equipment and receiver. 

- Connect the equipment into an outlet on a circuit different from that which the receiver is 
connected. 

- Consult the dealer or an experienced radio/TV technician for help. 

Unauthorized modifications to this equipment may void Lumagen’s limited warranty and the 
user’s authority to operate this equipment. 

Lumagen is a registered trademark of Lumagen, Inc. Vision HDP, Vision HDQ, RadianceXD, 
RadianceXE, RadianceXS and other Lumagen product names, are trademarks of Lumagen, Inc. 
Other trademarks are the property of their respective owners. 

WARNINGS: 
 

• Do not defeat the safety features of the power supply or power cord, such as, 
but not limited to, removing the ground pin connection. 

• Do not open, insert objects into, or spill liquid into, this equipment. 

• Do not block the cooling vents. 

• Do not program an output resolution that exceeds the maximum specified 
refresh rate of the attached television, or projector. 

• Improperly set gray-bar intensity may accelerate screen burn-in. Consult a 
home-theater specialist for help setting gray-bar intensity. 
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Section 1 – Getting Started 

Introduction 
Thank you for purchasing a Lumagen® Radiance™ video processor. The Radiance family of products boasts 
the highest-performance video switching, processing and calibration available. This makes it ideal for high-
definition home and commercial theater applications 

The RadianceXS combines proprietary strides in video technology with enhanced connectivity and the 
flexibility of up to 10 video and 11 audio inputs. A dual-SD-SDI input option is also available. Lumagen’s 
Radiance series refines and enhances the video images presented by high definition front projectors, top-
level rear-screen and flat-panel displays. At the same time the Radiance functions as an extensive central 
switching hub ideal for home and corporate theater systems. 

By incorporating improved video de-interlacing, new MPEG artifact reduction and temporal noise reduction, 
the Radiance series expands upon the company’s well-known Vision series – a line which received industry 
recognition in 2005 and 2006 for advancements in switching, calibration and proprietary No-ring™ scaling 
technologies. 

The Radiance offers 10-bit processing, per-pixel standard definition (SD) and high definition (HD) video de-
interlacing with adaptive diagonal filtering, scaling technology that does not add ringing (unlike competing 
products), MPEG mosquito and block artifact reduction and temporal noise reduction for both SD and HD 
sources. For these reasons, the Radiance™ processor sets the industry benchmark for switching, calibration 
and video processing performance. 

Key Features 
• 10-bit processing for deinterlacing plus a 12-bit calibration pipeline 
• Proprietary Lumagen No-ring™ scaling 
• Optional support for HDMI 1.4 3D 
• Each input has 4 user configuration memories 
• Each user configuration memory has 8 resolution sub-memories (for HD inputs) 
• Each resolution sub-memory is linked to one of 8 output configurations. 
• 2:2, 3:2 and 3:3 pull-down for SD/HD film sources  
• Per-pixel SD/HD video de-interlacing 
• Adaptive diagonal filtering 
• MPEG mosquito and block artifact reduction 
• Temporal noise reduction for SD and HD sources 
• Output resolution from 480p to 1080p, plus 1080i 
• User programmable non-linear-stretch (NLS) mode 
• 4:3, LBOX, 16:9, 1.85, 2.35 and NLS input aspect ratios 
• Programmable output aspect ratio from 1.33 to 2.50 
• Extensive support for anamorphic lenses 
• Automatic detection for NTSC, PAL and SECAM  
• Extensive suite of test patterns 
• Parametric grayscale calibration 
• Parametric Gamma 
• Full CMS (Color Management System) for primary and secondary color calibration 
• Programmable input/output color-space 
• Y/C-delay calibration 
• CUE and ICP filtering 
• Eight channel audio up to 192 kHz, DD True-HD™ 5.1, and DTS Master Audio™ 5.1 
• IR and RS232 control inputs (See Tech Tip 11) 
• RS232 control output 
• LVTTL IR format command input LVTTL IR format command input (See Tech Tip 9)  
• Universal power supply, INPUT:100-240V~50/60Hz, 0.8A OUTPUT:5.0V, 5.0A 
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Document Conventions and Menu Navigation 
Commands are selected with the supplied infrared remote or the RS232 serial port. To prevent possible 
command conflict, only one of these methods of command should be used at a time.  See the Serial RS232 
Command Interface section for information on serial commands. The infrared remote control command 
notation is described below: 

• Remote buttons are named as shown on the remote in a bold font. Example: MENU. 
• For comma separated lists, press the buttons in the sequence shown. 
• For parenthesized lists, select one button from the list. 
• For square-bracketed lists, press the buttons as needed. 

Example: For the list [�, �, �, �], press the arrow keys as needed. 
• For menu commands press the MENU button. The � and � arrow keys are used to select the 

function. The � arrow key (or OK) is used to enter sub-menus. This is shown as: MENU → 
MenuItem → MenuItem. The � arrow key (or EXIT) steps up one menu level. 

• Numerical entries are listed as value. The � arrow key acts as a backspace key. 
• Some commands are activated immediately without the need to press OK. Other commands must 

be explicitly accepted by pressing OK. If needed, OK is listed as part of the command, and will 
complete the command and return the menu to one level higher in the menu system. 

• For many commands, pressing EXIT cancels a partially completed command and returns to one 
level higher in the menu system. For advanced commands changes are completed from within 
the command and EXIT just returns to one level higher in the menu system. 

• There are four independent configuration memory types for each input (MEMA, MEMB, MEMC 
and MEMD). The input setup and output resolution/timing can be set independently for each 
memory. To program an input memory, first select the input, then select the desired 
configuration memory and use the menu system to configure. 

• Some menu commands are only available when their associated input is selected. 
• Before changes are saved, they can be discarded by entering standby (STBY) mode. 
• A Save must be performed after any changes or all changes will be discarded the next time the 

unit enters standby (STBY), or power is lost. To save press   MENU, �, OK, OK, OK. 

Unpacking 
• Unpack the box.  
• Make sure that you remove all of the accessories from the packing.  
• Save the box and packing materials in case you need to ship your Radiance. 

Verify that your box contains the following items: 
• Lumagen Radiance video processor 
• Universal power-supply, INPUT: 100-240V~50/60Hz 
• Remote control 
• AAA Batteries (2) 
• Rack ears 
• Radiance Owner’s Manual 
• RS232 Null-modem cable 

Remote Control Battery Installation 
Use the following procedure to install batteries in the remote: 

1. Locate the battery compartment on the back of the remote control. 
2. Move the locking tab to open the door. 
3. Remove the old batteries (if applicable). 
4. Install two new AAA batteries, observing the battery polarity shown in the battery compartment. 
5. Replace the battery compartment cover. 

Installation Guidelines 
• Install the Radiance on a flat, level surface such as a table or shelf. 
• Alternately the Radiance can be installed in an equipment rack by using optional rack ears. 
• Select a well-ventilated, dry location. 
• Verify that the cooling vents are clear of obstructions to provide convection cooling. 
• Only use the a Lumagen approved power supply. 
• Avoid sudden temperature changes, temperature extremes and excessive humidity. 
• Unplug power to the Radiance before cleaning. 

 



 Section 2 – Overview    

RadianceXS  rev 11/17/10  3

Section 2 – Overview 

Front Panel 
 

 

 

The front panel has a light-emitting-diode (LED) indicator, which is red when the unit is in “standby” and, by 
default, is green when the unit is “on.” Note that the green “on” indicator can be turned off if preferred. 

 

 

 

Rear Panel 
 

 

 

There are four HDMI and six analog video inputs. Audio can be received on the active HDMI input, one of 
two analog stereo inputs, or one of five digital audio inputs (2 TOS, plus 3 COAX). 

There are two HDMI audio/video outputs and one COAX audio output. Video can be output on one or both 
of the HDMI outputs. Audio can be output on the HDMI outputs and/or the COAX output. 

Additional connections are provided for LVTTL command input (38 KHz IR format), RS232 command output, 
RS232 command input/update, plus the 5 VDC power input. 

These connections are described on the following page. 
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HDMI Connections 

 

 4 HDMI SD/HD Inputs. Supports resolutions from 480i/576i up to 1080p60 
2 HDMI SD/HD Outputs. HDMI1 supports video resolutions from 480p/576p up to 1080p60 

with support for HDMI 1.3 audio formats. 

Note: CEC bit pass-through connected from HDMI inputs to HDMI Output 1. 

Analog Video Input Connections 

 

2 Component / RGsB Inputs / RGBcvS. Supports resolutions up to 720p60, 1080i30. Input 8 
can be used as an RGBHV Input. In this Mode VSync uses Input 9, and HSync uses Input 
10. Each of these inputs can support RGBcvS. For RGBcvS, an input is combined with the 
adjacent composite video input (i.e. Input 8 + cvS on Input 10). 

2 S-video Inputs. Supports NTSC, PAL and SECAM. 
2 Composite Inputs. Supports NTSC, PAL and SECAM. 

Audio Input and Output Connections 

 

2 Stereo Analog Audio Inputs 
2 Optical Digital Audio Inputs 
3 COAX Digital Audio Inputs 
1 COAX Digital Audio Output 

Miscellaneous Connections 

 

1 IR format command input (See Tech Tip 9 on the Lumagen.com website). 
1 RS232. Used for command input and for software update (See Tech Tip 6 and 11). 
1 RS232. Used for command output. Typically used to turn a display on and off. 
1 Power Input (5 Volts DC) 
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Remote Control 
 

 

 

Power / Standby 
ON Power On 
STBY Standby 
 
Navigation Control 
CLR Clear menu or partial commands 
HELP Display context-sensitive help 
EXIT Go back one menu level 
OK Enter/Accept command, display info screen 
� Menu navigation / zoom in 
� Menu navigation / zoom out 
� Menu navigation / input aspect 
� Menu navigation / input aspect 
 
Numeric Entry 
1-9 Input 1 to 9 
+10 Input 10 and greater 

Picture-In-Picture (PIP) 
OFF Not available for RadianceXS 
SEL Not available for RadianceXS 
SWAP Not available for RadianceXS 
MODE Not available for RadianceXS 
 

Input Aspect Ratio 
4:3 4:3  (1.33) aspect ratio 
LBOX Letterbox 
16:9 16.9 (1.78) aspect ratio 
1.85 1.85 aspect ratio 
2.35 2.35 aspect ratio 
NLS Non-Linear-Stretch 
 
Misc Buttons 
INPUT Precedes input # selection  
ZONE <not implemented> 
ALT Alternate info screens 
PREV Previous output 
 
Configuration Memories 
MEMA Memory A 
MEMB Memory B 
MEMC Memory C 
MEMD Memory D 
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Block Diagram 
The function of the Radiance is to act as a video switch, process the selected video source and then output 
video in the appropriate format and resolution. Standard definition (SD), enhanced-definition (ED), high-
definition (HD) video inputs, plus a number of PC formats are supported. Video inputs are converted to 
progressive video (if necessary) and are then scaled to the video output resolution. 

Interlaced video has been in use for more than 50 years and is still the most common video format. It 
displays half of the lines of picture information each sixtieth (or fiftieth) of a second. Each half of the image 
is called a field and displays either all the even lines, or all the odd lines. So, an entire image, called a 
frame, takes a thirtieth (or twenty-fifth) of a second to display on the screen. An “i” suffix on the resolution 
specification is used to indicate interlaced formats. 

In contrast, progressive video presents each frame as a whole. A “p” suffix on the resolution specification is 
used to indicate progressive formats. Converting interlaced video to progressive video is referred to as 
“deinterlacing.” 

The Radiance is comprised the following major functional sections: 

• Video input selection with conversion to digital (if needed) and video decoding 
• Video deinterlacing 
• Video filtering and scaling 
• Video output of HDMI digital video 
• Audio input selection 
• Audio control 
• Audio output encoding 

The functional blocks are shown below. 

 

 

 

Composite and SVideo inputs automatically select between NTSC, PAL and SECAM formats. The component, 
RGB and HDMI inputs accept SD, ED and HD video at 24, 50 or 59.94 Hertz. HDCP encryption is supported 
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for the HDMI inputs. This is not just a “pass-through” function. If the signal is encrypted, the HDMI inputs 
are decrypted, processed, scaled and then re-encrypted for output as HDMI. For HDCP encrypted inputs, a 
HDCP capable display is required. 

If the video input is interlaced, it is first deinterlaced into a progressive format. User enabled noise reduction 
algorithms are then applied. Proprietary No-ring™ scaling algorithms are used to scale the resulting 
progressive video to the optimal size for the display. 

As part of the scaling process, digital filtering is used to enhance the image detail. This enhancement allows 
standard definition inputs, such as DVDs, to appear to be much higher resolution. This is especially valuable 
when standard-definition sources are viewed on the large screen sizes common in home theaters.  

Commands can be sent by infrared remote or via the serial RS232 port. The RS232 port is used for software 
updates. Setup is done with the on-screen menu. User functions (e.g. select input) use direct commands. 

Configuration Memories 
To understand how the Radiance functions, it is important to note that setup and calibration parameters are 
split into “input memories” and “output configurations.” Input memories control video source setup. Output 
configurations control display setup and calibration and are specified by selecting a Mode, CMS and Style for 
each input, input-memory, and input sub-resolution memory. 

The Radiance has four input memories (MEMA, MEMB, MEMC and MEMD). Each input memory has eight 
sub-memories that are automatically selected for input resolutions of 480, 576, 720p, 1080i50, 1080i60, 
1080p24, 1080p60 and Other. The “Other” memory is reserved as a “catch-all” for unspecified resolutions. 

The following applies to software revision 102910, and later revisions: Each Input sub-resolution memory 
can be independently linked to any one of the eight output mode, CMS and style memories. They store 
setup data for the video display setup and calibration. In the factory default condition all input sub-
resolution memories are linked to “Mode 0,” “CMS 0,” and “Style 0.” To change these enter MENU → Input 
→ Video Setup → [resolution]→ Out1 Select → (Mode, CMS, Style). These settings can be changed 
for each input sub-resolution memory. To “Save” new settings, enter MENU → Save → OK → OK → OK. 

Default “Input Memory” to “Output ” configuration (for 102910, or later, software)

MEMA

480
576

720p60
1080i50
1080i60
1080p24
1080p60

Other

MEMB

480
576

720p60
1080i50
1080i60
1080p24
1080p60

Other

MEMC

480
576

720p60
1080i50
1080i60
1080p24
1080p60

Other

MEMD

480
576

720p60
1080i50
1080i60
1080p24
1080p60

Other

Mode 0
Mode 1
Mode 2
Mode 3
Mode 4
Mode 5
Mode 6
Mode 7

CMS 0
CMS 1
CMS 2
CMS 3
CMS 4
CMS 5
CMS 6
CMS 7

Style 0
Style 1
Style 2
Style 3
Style 4
Style 5
Style 6
Style 7
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Section 3 – Quick Start Guide 
There are a number of system configurations that can be used when installing your Radiance. Which one you use 
will depend on the specifics of your installation, such as if you have multiple displays and how you connect audio. 

Basic Setup Information 
STEP 1 – Connect the Radiance outputs 

1. Typical system configurations are shown in the System Configuration Examples section. 
2. The Radiance has two HDMI outputs that can be used to drive displays and/or audio processors. 

DVI displays are compatible with HDMI and can be connected using an HDMI-to-DVI cable. 
Lumagen recommends against using an HDMI-to-DVI adaptor to connect to a DVI device, as this 
extra connection has been known to compromise the audio/video data. 

3. To simplify setup, if using an Audio-Video-Receiver (AVR), connect it to Radiance HDMI Output 1 
or use the audio COAX Output. If a TV is connected without an AVR it should be connected to 
Output 1. By default, when connecting to HDMI Output 1, the Radiance automatically detects the 
supported Audio modes by reading the AVR’s EDID and reports these back to all HDMI sources. 
Use an HDMI cable, or coax cable to connect to the amplifier input, as appropriate. If the Radiance 
COAX audio output is used, set the audio EDID mode to “USER1 EDID” in the Audio menu. 

4. For a projector, or display, when audio to the display is not desired, connect it to Output 2. Use an 
HDMI, or HDMI-to-DVI, cable to connect to the display input. 

5. By default, the Radiance automatically detects the optimal output resolution and vertical rate for 
HDMI and DVI displays. For analog displays the output resolution must be manually selected. 

6. Set the output color format and level. YCbCr 4:2:2 is the optimal mode to use, if the display 
supports it. For RGB format it is important to match the display’s specified input level (video or 
PC). The command is: 

 Menu command: MENU → Output → Configs → [Config] → HDMI Format → Type → 
(YCbCr422, YCbCr444, RGB-PC level, RGB-Video level) 

NOTE:  
For best switching, and power-on, times manually select the output resolution and select “USER1 EDID” for the 
audio mode. For example, for a 1080p60 display pressing MENU 0 2 7 OK selects 1080p60 and eliminates the 
need for the Radiance to read the display video EDID. Selecting “Always”, and “USER1 EDID” in the Audio menu 

eliminates the need for the Radiance to read the audio EDID information from the AVR/TV. See the Output 
Configuration Commands section, and Audio section, for more information. Remember to save any changes. 

STEP 2 – Connect the sources to the Radiance 
1. Use the appropriate cables to connect the video and audio outputs of your sources to the 

appropriate inputs on the Radiance. See the Source Device Connection Examples section for some 
examples. 

STEP 3 – Power up the Radiance 

1. Plug the DC power cable, from the external power supply, into the 12 VDC power connector on the 
back of the Radiance. Warning: Use only the Lumagen power supply. 

2. Plug the removable AC power cord into the connector on the external power supply.  
3. Plug the AC power cord into a power outlet. (100-240V at ~50/60Hz) 
4. The LED on the front panel of the Radiance will light up with a red color. 
5. To turn on the Radiance, press the “ON” button on the remote. 
6. The LED on the front panel of the Radiance will change to a green color. 

STEP 4 – Select an input on the Radiance 
1. Select an active video input by using the numeric keypad on the remote control. For inputs 1 

through 9, press the “Input” button and then press the corresponding number button on the 
remote. For inputs 10 through 18, press the “Input” button, press the “+10” button, then press 
the corresponding number button on the remote (i.e. For input 11, press “Input, +10, 1”). 

STEP 5 – Check for an image 
1. You should now have an image from your selected active video source visible on your display. 
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System Configuration Examples 
The most common configurations using the Radiance are shown below. 

1. Receiver after Radiance. 

Placing the AVR and display after the Radiance is generally the optimal configuration. Connect your AVR to 
Radiance Output 1, your display/projector to Radiance Output 2, connect your sources, then power 
everything on. The Radiance automatically detects and selects the appropriate audio and video modes. 

This configuration can improve switching delays using the Radiance’s fast input switching, and guarantees 
the video is not degraded by the AVR. It also minimizes the work needed to configure the Radiance since, 
for output 2, audio is turned off by default. Note, some amplifiers do not accept audio for non-standard 
video rates, such as 768p, or at any rate above 720p/1080i, and some amplifiers will not report EDID back 
to the Radiance unless the amplifier’s HDMI output is turned off, or is driving a display. If you connect the 
Radiance coax audio output to a receiver, you can use HDMI audio or coax/SPIDF audio input from the 
video source but you need to change the Radiance Audio EDID to one of the “USER” modes in the main 
audio menu. See the Audio section of this manual for more information. 

 

2. Audio and Video routed separately. 

Connect the display to Radiance HDMI Output 2. This output has its audio turned off by default and so is 
correct by default for this case. 

 

3. Receiver in front of Radiance. 

Connect the display to Radiance HDMI Output 2. This output has its audio turned off by default and so is 
correct by default for this case. 
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4. Receiver in front of and after the Radiance. 

Connecting the Radiance both in front of and after the AVR is not recommended, but can be used in special 
circumstances. This connection scheme can cause HDCP authentication loops, which cause power up and 
switching issues in some systems. 

Connect the AVR’s HDMI video output to an appropriate Radiance video input, and connect the Radiance’s 
Output 1 to an appropriate AVR input. Connect the display’s HDMI input to the Radiance’s HDMI Output 2. 
Change the Audio EDID in the main Audio menu to “User1 EDID.”  If the AVR output is intended only for 
displaying the AVR’s On-Screen-Display, Lumagen recommends using a Radiance analog video input. 

 

Source Device Connection Examples 
The following illustrations show the types of cables, which can be used to connect typical video sources to 
the Radiance. Multiple possibilities are shown for some sources, but only a single audio and a single video 
connection are required. 

VCR/Laser Disk/DVR 

 

DVD Player/DVD Recorder 
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HD-STB / dVHS / HD-DVD / Blu-ray 

 

PC 

Connecting a PC using a DVI to HDMI cable is preferred, but Input 10 can be used as an analog 
VGA (RGBHV) input. Use the Y channel for green, the PR channel for red and the PB channel for 
blue, Input 17 for VSync, and Input 18 for HSync. 

 

SCART (RGBcvS) 

Note: For RGBcvS, a component input is combined with the adjacent composite video input (e.g. 
component Input 10 + cvS on Input 18). 
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Section 4 – Basic Commands 

Power 
Turn power on by pressing the ON button. Place the Radiance in standby-mode by pressing STBY. 

Input Selection 
The eighteen video inputs are numbered 1 to 18. For inputs 1 through 9, press the “Input” button and then 
press the corresponding number button on the remote. For inputs 10 through 18, press the “Input” button, 
then the +10 button and then the corresponding number button on the remote (i.e. For input 11, press 
“Input, +10, 1”). 

Shortcut:  
If the menu is not displayed on the screen, inputs 1 through 9 can be selected 

by just pressing the corresponding number button on the remote. 

If desired, the “Input” button can be programmed to display a screen with the inputs listed as a menu-
table. Then the desired input can be selected either with the number keys, or by using the arrow keys to 
highlight the desired input and then pressing the OK button. The command to enable the input menu is: 

MENU → Other → Menu control→ Menu Options → Input Menu → (Off, On) 

Configuration Memory Selection 
Each input has four configuration memories. These are referred to as memory “A,” “B,” “C,” and “D.” To 
select one of these memories press MEMA, MEMB, MEMC, or MEMD, respectively. Note, RS232 codes are 
provided to directly access these memories. Each input memory has eight input “sub-memories” that are 
automatically selected based on the input resolution. 

Each configuration memory, and sub-memory, is independent of the other memories. To allow the 
memories to be used for mode selection (e.g. day/night), the type remains unchanged when a new input is 
selected. (i.e. If input 2 memory B is active, pressing “Input, 3” selects input 3 memory B). 

Input Aspect Ratio Selection 
The input source aspect ratio can be selected by pressing the 4:3, LBOX, 16:9, 1.85, or 2.35 button. To 
use the NLS feature, press “4:3, NLS”, “16:9, NLS”, or “1.85, NLS”. 

• Use 4:3 for standard definition full-screen material.  
• Use LBOX for “letterbox” standard definition material, such as analog-television movies shown 

with black bars above and below the image.  
• Use 16:9 for material labeled as “Enhanced for 16:9 televisions”. 
• Use 1.85 for material labeled as “Aspect ratio 1.85”. 
• Use 2.35 for material labeled as “Aspect ratio 2.35”. 
• Use NLS to apply a horizontal non-linear stretch, to stretch 4:3 to 16:9, or 16:9 or 1.85 to 2.35.  

NOTE:  
Make sure the “display aspect ratio” setting is 16:9 in the setup menu of all video sources 

(e.g. DVD players or set top boxes), even if your display is not 16:9. 

Image Zoom 
After the input aspect ratio has been selected, the image can be zoomed in to better fit the screen. The 
zoom function uses the � and � arrow buttons. When the menu is off, by default, the � arrow button zooms 
in and the � arrow button zooms out. 
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Status Screen 
Pressing “OK” when the menu is off displays an on-screen information message as shown in the example 
below. 

Radiance info Pg 1 
     SW Rev.xxxxxx         Serial:xxxxxxxxx 
                   Input 1A    Out1        Out2 
 Resolution:  480i          720p         720p 
 Refresh:      59.94Hz     59.94Hz    59.94Hz 
 Color Fmt:   YCbCr 422  RGB          RGB 
 HDCP:         On            On            Off 

Pressing “OK” when the information screen is displayed, will display a second status screen as shown in the 
example below. 

Radiance info Pg 2 
Audio:HDMI1      
In aspect=16:9   Out aspect=1.78   Zoom=0% 
X scaler: On   AdjInHres: 1914   OutHRes:720 
Y scaler: On   AdjInVres: 1077   OutVRes:480 
Genlock: currently off 
  

On-Screen Help 

Pressing, “HELP” when the menu is displayed, displays on-screen help information for the currently 
highlighted menu item for many of the menu options. 

Quick Keys 

If you use a basic universal remote to control the Radiance, you can activate an optional menu that allows 
you to use the Radiance menu to set input aspect ratio (4:3, LBOX, 16:9, 1.85, 2.35, NLS), set zoom 
(Zoom+, Zoom-) and select the user memory (MemA, MemB, MemC, MemD). The “Quick Keys” menu 
duplicates the function of pressing the corresponding buttons on the Lumagen remote. 

MENU → Other → Menu control→ Menu Options → Quick Keys → (Off, On)  

MENU → Quick Keys → (4:3, LBOX, 16:9, 1.85, 2.35, NLS, Zoom+, Zoom-, MemA, 
MemB, MemC, MemD) 
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Section 5 – Video Configuration 

Output Video Configuration Commands 
By default the output is set to Mode0, “Auto 2,1.” The selection “Auto 2,1” means the Radiance 
automatically reads the EDID for the devices connected to both outputs, giving priority to Output 2, and 
automatically selects the appropriate output resolution. That is, if an active device is connected to output 2. 
the EDID from that device is read to determine the optimal video output resolution and the Radiance 
automatically selects the specified resolution. If no device is connected to output 2, or the device connected 
to output 2 is turned off, the Radiance uses the EDID from the device connected to Output 1 and sets the 
output resolution appropriately. Output 1 can have priority by selecting “Auto 1,2” from the Video Output 
Select Menu menu.  

For “Auto” modes the output vertical rate is selected based on the input vertical rate. For example, input 
formats 480i60, 720p60, 1080i60 automatically select a vertical output rate of 60 Hertz. For 576i50, 720p50, 
and 1080i50 inputs a 50 Hertz output rate is selected. For 1080p24 inputs a 24 Hertz output vertical rate is 
selected (if the display allows, otherwise a 60 Hertz output vertical rate is selected).  

For analog displays, and digital displays that do not properly support EDID, the output Mode must be 
selected using commands shown below. 

Video Output Select Menu 
Note: 

This section assumes that software 102910, or newer, is loaded in your Radiance 

The output Mode, CMS, or Style, are selected using the Video Output Select Menu. The Video Output Select 
Menu does not affect the audio settings. See the Audio Configuration section for information on configuring 
audio modes. Once selected, the parameters for the Mode, CMS, and Style are changed using the MENU → 
Output → (Modes, CMS’s, Styles) menus. 

The Video Output Select Menu can be accessed in two ways. To make global changes to the output mode, it 
is accessed from the output menu. To make changes for a specific input sub-resolution memory, it is 
accessed from the input video setup menu. An example of the Video Output Select Menu for Output 1 is 
shown below: 

Input Out 1 Mode CMS Style 

If 2D:    Mode0 CMS0 Style0 
  (Auto 2,1)   

If 3D:   Auto 2,1 CMS0 Style0 

From MENU → Output → Output1 → Global Setup menu the Video Output Select Menu globally 
changes the output Mode, CMS or Style for 2D, and 3D. It can select these for a single input, or for all 
inputs. After the selections are made and you press OK, the menu asks for the extent to which the change 
should be applied (“current input” or “all inputs”). Use the left and right arrow keys to change the extent as 
needed and then press OK. All input sub-resolution memories for the selected input(s) are changed to the 
new selections. 

To select the output Mode, CMS or Style for a specific input sub-resolution memory, first select that input, 
and send the desired resolution to that input. NOTE: In Service mode, any sub-resolution memory for the 
current input can be updated independent of the current input resolution. Select the desired Mode, CMS, 
and Style using Video Output Select Menu under the MENU → Input → Video Setup → [Input 
Resolution] → Out1 Select menu. Once changes are made and you press OK, the menu asks for the 
extent to which the change should be applied (e.g. “This Input Resolution, This Mem”). Use the left and 
right arrow keys to change the extent as needed and then press OK. 

If HDMI output 1 is driving an AVR where you only need audio, selecting “Video Off” for output 1 can speed 
up changes due to input video/audio selection and input selection. If an output is driving a non-3D AVR, 
then it is important to turn off that Radiance output’s video when selecting a 3D source. If video is turned 
off for output 1, the Video Output Select Menu can be used in the same way to change the Mode, CMS or 
Style for output 2.  

Note: 
2D and 3D each have their own mode. For current software the 3D Mode is always “Auto.” However, the 
CMS and Style can be changed. If the 3D option has not been installed, the 3D modes are not applicable 
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Output Mode – Global Presets 
This command is not generally needed. However, it can be useful when driving displays that do not report 
EDID and where no video is visible until a specific format is sent. It changes the Output Mode for all Inputs 
and input memories. 

Select the Output Mode from the table below. The command is: 

 MENU → Output → Configs→ [Config] → Select Mode → OK 

The direct commands to select output resolution are: 
  480p60:   MENU 0 2 1 OK    540p60:  MENU 0 2 2 OK  

  720p60:   MENU 0 2 4 OK    768p60:  MENU 0 2 5 OK  
  1080p60: MENU 0 2 7 OK    1080i60: MENU 0 2 8 OK 

Sync Polarity 
By default the output sync polarity is selected automatically. This command allows the user to override the 
automatic selection. The command is MENU → Output → (Output1, Output2) → SyncPolarity.  

Configuration 
By default the display’s 3D capability is automatically detected using its EDID information. However, some 
3D displays do not properly report their 3D capability in their EDID. This command allows the 3D output 
capability to be manually enabled (or disabled). The command is MENU → Output → (Output1, 
Output2) → 3D.  

Exact Output Timing 
After selecting an output format, its timing can be modified on a pixel basis. Do not change the timing using 
this menu unless it is really needed. Some digital displays lose picture if timing is changed by even a single 
pixel. The command is:  

MENU → Output → Configs → [Config] → Timing → Mode Timing 

Rate Match 
Some material may be sourced at 24.00/60.00 Hertz refresh rates instead of the standard 23.98/59.94 Hertz 
rates. It is desirable to slightly alter the output rate to match the input rate as long as the display works 
with these different rates. The default setting is 'Off.' Use 'Off' if your display will not accept these rates. 
The command is:  

MENU → Output → Configs → [Config] → Timing → Rate Match → (On, Off) 

Screen Aspect Ratio 
Select the screen aspect ratio. The screen aspect ratio range is 1.10 to 2.50 and is entered in units of 
hundredths (e.g. 16:9 is entered as 1 7 8). If you have a normal fixed aspect display, select the “Single 
output aspect” which is the default setting. If you have a movable anamorphic lens, select “Output aspect 
per input aspect”. 

There is a special case when you use NLS input aspect with “Output aspect per input aspect”. When the 
input aspect is 4.3+NLS the output aspect assigned to the 16:9 entry is used. When the input aspect is 
LBOX+NLS, 16:9+NLS, or 1.85+NLS the output aspect assigned to the 2.35 entry is used. The command is: 

 MENU 0 6 (Single output aspect, Output aspect per input aspect) OK xxx OK 
or MENU → Output → Configs → [Config] → Aspect Ratio → (Single output aspect, 
Output aspect per input aspect)  → Ok → xxx → Ok 

Graybar Intensity 
NOTE:  

Consult a home theater specialist for assistance setting the graybar intensity. 

Some degree of burn-in will occur on any susceptible display, but this command can help minimize it by 
allowing the intensity of the graybars to be adjusted. The command is: 

MENU → Output → Configs → [Config] → Other → Graybar → (Sides, Top/bottom)  
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Output Type 
You can specify the digital output range as “RGB-PC level” (e.g. for 8-bit 0 to 255) or “RGB-Video level” 
(e.g. for 8-bit 16 to 235). “YCbCr 422” is the recommended output format. For the HDMI RGB output, 
setting the level as video allows blacker-than-black and whiter-than-white. The command is: 

MENU → Output → Configs → [Config] → HDMI Format → Type → (YCbCr422, 
YCbCr444. RGB-PC level, RGB-Video level)  

Dither 
Some fixed pixel displays show contouring on images that have gradients because the actual repixel depth 
of each pixel is limited. The dither control can be used to enhance the resolution of the display and reduce 
contouring. Dither position sets the bit size of the pixel for dithering. Orientation controls the frame-to-
frame randomization and can be fixed of dynamic. Masking can be turned on to clear the lowest bits after 
the dither position. The command is: 

  MENU → Output → Configs → [Config] → HDMI Format → Dither 

Mask 
The "mask" command allows you to “blank” the edges of the video image on the output without changing 
its position or scaling. This is useful to blank bad pixel data from the source that shows on screen, when you 
want to keep the “pixel perfect” setup (i.e. no scaling). The gray level of the mask is adjustable from black 
to white in sixteen steps. The command is: 

 MENU → Output → Configs → [Config] → Mask/Shrink → Mask 

Shrink 
The “shrink” command allows you to adjust the image size to fit inside a screen masking system. This 
command is useful for rear-screen and flat-panel displays when the manufacturer uses too much 
“overscan”. The command is: 

 MENU → Output → Configs → [Config] → Mask/Shrink → Shrink 

Gamma Factor 
The Gamma Factor adjusts the gamma of the video output up or down. Since the Radiance is in the middle 
of the video chain, its default goal is to not affect the image Gamma and so the default Radiance gamma of 
1.00. Changing the Gamma Factor allows the Radiance a “coarse correction” control for display Gamma. It 
should be set to (Desired_Gamma / Measured_Gamma). The command is: 

 MENU → Output → Configs → [Config] → Color Mgmt → Gamma Factor → OK 

Copy Output Settings  
This command copies the current output configuration to the selected output configuration or 
configurations. You can choose whether to copy the mode settings, shrink settings, aspect settings, color 
management settings and other settings. The command is: 

MENU → Output → Copy→ OK 
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Input Configuration Commands 
After the output is configured, calibrated, and saved, you can calibrate the first input. Note that most often, 
no input calibration is necessary. After calibrationg the first input, you can copy that configuration to all the 
other configuration memories if desired. Then calibrate other inputs. To program one of the independent 
input memories, select the input, then select the configuration memory and use the menu to configure the 
input. For example, if memory A been calibrated and a second configuration is needed, start by copying 
Memory A to memory B for that input to reduce setup time for the second configuration. 

HDMI Input Color Format 
Inputs 1, 2, 3, 4, 5 and 6 are HDMI. By default the appropriate color space is automatically selected (“Auto” 
mode) for standard-definition “Bt.601” or high-definition “Bt.709.” The “Auto” mode is generally best, but 
some upscaling sources do not convert the color format to Bt.709 as they should and so “Bt.601” would be 
manually selected for these if they are programmed to output HD formats. The command is: 

MENU → Input → Video Setup → [Resolution] → Picture → Color Format → OK 

HDMI Video Type 
By default the HDMI input format is detected automatically. For DVI sources that do not report their format, 
the input format can be selected manually. The command is: 

MENU → Input → HDMI Setup → Type → (Auto, YCbCr 444, YCbCr 422, RGB) 

HDMI Physical Input 
If desired the input selection for HDMI sources can be assigned to different physical HDMI inputs. This can 
be useful if a receiver or HDMI switcher is used to switch several HDMI to a single input on the Radiance. 
Different settings and calibrations for several virtual HDMI inputs can be stored for the same physical HDMI 
input. The command is: 

MENU → Input → HDMI Setup → Physical In → (1, 2, 3, 4, 5, 6) 

Component/RGBHV/SCART Input Setup 
For analog inputs 7, 8, 9 and 10 if the input format is not component video, the source type can be changed 
to match the input. Select the input and then program its format. The command format is: 

MENU → Input → Analog Setup → Type → (Component, RGBHV, RGsB, RGBs, Scart)  

The component input gain can be reduced if the input levels are over specification, such as some video 
games. An incorrect setting can give white crush or a low white level. In this case, set this control to 
“Reduced” to correct the white level. The command is: 

 MENU → Input → Analog Setup → A2D Gain → (Normal, Reduced) 

For HD inputs, you can select the color-space as “Auto,” standard-definition “Bt.601,” or high-definition 
“Bt.709.” The “Auto” mode is generally best, but some upscaling sources do not convert the color format to 
“Bt.709” as they should. In this case “Bt.601” should be selected. The command is: 

  MENU → Input → Video Setup → [Resolution] → Picture → Color Format → OK 

Selecting an Output Configuration for an Input Memory 
NOTE:  

The following section assumes that software 102910 or later is installed in your Radiance. 

The output-Mode, CMS and Style for each sub-memory can be set independently. Each input memory 
“resolution sub-memory” points to a Mode, a CMS, and a Style memory. For HD capable inputs, each 
memory has eight resolution “sub-memories” which are set to default values of 480, 576, 720p60, 1080i50, 
1080i60, 1080p24, 1080p60 and Other and automatically selected based on the input resolution and rate. 
The “Other” sub-memory is used for any input resolution that isn’t one of the specified input resolutions.  

See the Video Output Select Menu section for additional information on connecting an input memory to an 
output Mode, CMS and Style 

HDMI input EDID Display Information 
EDID is information that can be read over DVI/ HDMI cables to influence how source devices deliver video, 
which helps produce an optimal picture. There are 4 settings for the Lumagen EDID interface. The default 
setting enables all of the display modes the Radiance supports. The User defined setting allows the user to 
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individually select which capabilities will be advertised to the source. You can scroll through the list of 
capabilities with the up/down arrows and toggle advertising the feature with the left/right arrows. With the 
Passback setting, the Lumagen will read the EDID from the display/AVR connected to the selected output 
and pass that back to the source. 

NOTE:  
Lumagen recommends using default video EDID or user-defined video EDID. This 

enables the Radiance to report video EDID back to the sources even when the 
display is off, and it can also improve power-up and switching speed. 

The command is: 

MENU→ Input→ HDMI Setup→ Video EDID→ (Default, User defined, Passback Out2,  
       Passback Out1) 

HDMI input hotplug mode 
NOTE:  

Do not set Hotplug to “always on” unless necessary since this eliminates the 
ability of the Radiance to inform the source of a change in the EDID data. 

Hotplug alerts a DVI/HDMI device to downstream EDID changes when toggled. For some devices, such as a 
PC, it may be necessary to keep hotplug high at all times. The hotplug signal is part of a HDMI/DVI 
interface. The Radiance provides two hotplug settings, "Normal" and "Always On". The "Normal" behavior is 
to toggle hotplug signal sent back to the HDMI inputs when the EDID information needs to be updated. The 
will then read the EDID and make any necessary changes. If the device connected to the Radiance output 
toggles the hotplug to the Radiance then there may be some new EDID information to passback to the 
sources and, if hotplug is set to "Normal", hotplug on all the inputs may be toggled to achieve this. 

Some sources, such as PC's, stop sending video on HDMI/DVI, or enter sleep mode, when the hotplug signal 
is not asserted, so setting hotplug on the Radiance to "Always On" is a potential solution. As mentioned 
above, generally Hotplug should be set to “normal.”   

Sometimes the connectivity of a system can cause a "hotplug loop." An example this is when connecting the 
Radiance output to an audio receiver and then hooking the HDMI monitor output of the receiver to one of 
the Radiances' inputs. Then, if the Radiance toggles its Hotplug back to the receiver’s output, the receiver 
would check the Radiance’s EDID and then toggle its hotplug back to the Radiance to inform it about this 
new EDID. The Radiance again toggle Hotplug in response. This creates a continuing loop of HDMI activity 
that may not end. 

 MENU→ Input→ HDMI Setup→ Hotplug mode→ (Normal, Always On) 

Auto Aspect 
For HDMI sources (not DVI), aspect information may be sent from the source. Enabling HDMI Auto-Aspect 
allows the source to set the input aspect ratio. You can set “NLS when applicable” (non-linear stretch) in 
order to stretch the width to fill the screen based on the input and output aspect ratios. The Automatic input 
aspect ratio selection can be overridden by manually selecting an input aspect ratio. If the “Sticky aspect 
override” is on, this new aspect will be used until the input is reselected, the Input button is pressed, or a 
memory button is pressed. If the “Sticky aspect override” is off the next time a different HDMI auto aspect 
is received the aspect will change to that input aspect ratio. The command is: 

MENU→ Input→ HDMI Setup→ Auto Aspect→ (On, Off) 

Copy Input Settings  
Copy the input settings between memories. Applicable input settings can be copied between inputs. Some 
settings such as audio source are not copied. Other settings are only copied if it makes sense. i.e. a HDMI 
input type wouldn’t be copied to a component input. Copying the first input memory calibrated to other 
input memories can speed up the calibration process. Note that copying a SD input to a HD input, copies 
the SD memory to (only) the SD sub-memory of the HD input. The HD sub-memories for the other 
resolutions are not changed. Copying a HD input memory to a SD input memory copies the SD sub-memory 
of the HD input to the SD memory. Copying a HD input memory to another HD input memory copies each 
resolution sub-memory to the respective resolution sub-memory of the other HD input. The input copy 
command copies all user memory parameters to another input or user memory. The command is: 

MENU→ Input→ Copy→ OK 
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Input Picture Controls 

Black and White Levels 
To set the input’s black-level (also referred to as brightness) and white-level (also referred to as contrast) 
using the Lumagen controls, use a test pattern generator or select PLUGE pattern. Note that the input 
memory black and contrast are intended to compensate for variations in video source output levels. Use a 
Radiance contrast pattern and the display’s controls to set the display black and white levels. The command 
is: 

 MENU → Input → Video Setup → [Resolution] → Picture→ (Black, White)  

Color Format 
Bt.601 is used for SD/ED modes and Bt.709 is used for HD modes. If the source is outputting the wrong 
colorspace this command allows the input colorspace to be selected. The command is: 

MENU → Input → Video Setup → [Resolution] → Picture → Color Format → (Auto, Bt.601, 
Bt.709) 

Color and Hue 
NOTE: 

Set the display’s Color and Hue to their default values. 

Use a test pattern generator, or test disc, test pattern to set Color and Hue if necessary. Normally not used 
if the Color-Gamut is calibrated using the Radiance CMS system, unless the source has an error in its color 
decoder. 
The command is: 

MENU → Input → Video Setup → [Resolution] → Picture→ ColorDecoder→ 
(Color Offset, Hue Offset, Color Red, Hue Red, Color Green, Hue Green) 

Y/C Delay 
Adjust the horizontal Chroma timing in relation to Luma. It is suggested that you use a Y/C-delay calibration 
image from a test pattern generator of test disc to calibrate the Y/C-delay. The CB and CR channels are 
adjusted independently. The command is: 

 MENU → Input → Video Setup → [Resolution] → Picture → YC Delay → (Cr, Cb) 

Input Size Controls 
Scale Bias 
Scaling is normally on in order to adjust the source to exactly fit the output resolution. If the bias is set to 
“On”, scaling is enabled unless the input and output resolution match exactly. If the scale bias is set to “Off” 
scaling is disabled if the input and output resolutions are close. Scaling is disabled/enabled independently 
for horizontal and vertical. When the bias is off there can be small borders on the edges of the image. If 
these areas have bad video the output Mask command can be used to blank that portion of the image. The 
second page of on-screen status information indicates whether scaling is active. 

MENU → Input → Video Setup → [Resolution] → Size → [Aspect ratio] → Scale Bias → 
OK 

Input Sizing 
Input sizing can be used to compensate for active image size differences between sources. Note: The input 
size command does not affect the output size or position. Rather, it affects which input pixels are captured 
for processing. 

Use the Crop TopLeft command to select the top-left-most active input pixel. Use the Crop BotRight 
command to select the bottom-right-most active pixel. For standard-definition sources you should set these 
controls so that overscan is about 1.5% on all four sides. For digital high-definition sources, overscan may 
not be required. Cable and Satellite Boxes may require more overscan. Select the scanline using the � and � 
arrows, and the pixel using the � and � arrows. The command is: 

MENU → Input → Video Setup → [Resolution] → Size → [Aspect ratio] → (Crop TopLeft, 
Crop BotRight)   



 Section 5 – Video Configuration  

RadianceXS  rev 11/17/10  20 

Vertical Shift 
The vertical shift is an easy way to move the image up and down without changing the Input Sizing 
settings. There are 15 vertical settings that are shared between all input memories. Select the vertical shift 
setting and then the shift value. The command is: 

MENU → Input → Video Setup → [Resolution] → Size → [Aspect ratio] → Vert Shift → 
OK 

Non-linear Stretch 
Non-linear-stretch (NLS) is used to horizontally stretch a 4:3 aspect ratio source to fit a 16:9 aspect-ratio 
display or to stretch a 16:9/1.85 source to fit a 2.35 aspect-ratio display. The image is stretched by a 
constant amount in the center and by an increasing amount approaching the left and right edges. This 
eliminates the black sidebars normally seen when viewing lower aspect material on a higher aspect display. 
To use non-linear stretch press the “4:3”, “16:9” or “1.85” button and then press the “NLS” button. 

The goal is to stretch the image to fill the screen in a way that looks as natural as possible. The Lumagen 
NLS command is very flexible and allows the image to be adjusted to user preferences to achieve this goal. 
The NLS adjustments are center width, center stretch, top cropping and bottom cropping. The center 
section of the image is stretched by a constant ratio from 100% to 124%. The width of the center section 
can be set from 15% to 70% of the display width. By programming the center section width and stretch 
amount, the amount of non-linear stretch in the left and right sections can be optimized. In addition, the top 
and bottom cropping can be set from 0 to 12%. Increasing the amount of cropping reduces the amount of 
stretch near the left and right edges of the image. When setting the cropping parameters, it is 
recommended that the satellite/cable box menu be checked to assure that critical parameters remain visible. 

Some 4:3 sources fill the entire source image (e.g. DVD 16:9 movies), but other sources place a 4:3 image 
in the center of a 16:9 image (e.g. HDTV with up-scaled SD source). This latter case is seen as a “pillar-
boxed” image with black bars on the left and right. The “PILLARBOXED” parameter must be enabled for this 
case. The Lumagen will then crop the pillbox bars and stretch the active 4:3 image. 

For a 16:9 display, when 4:3 NLS is enabled, the image will fill the screen with a 4:3 (1.33) source for any 
output aspect ratio up to 1.85. If the output aspect ratio is greater than 1.85, software limits the maximum 
width to the equivalent of 1.78 and adds left and right sidebars. 

For a 2.35 display, when 16:9 NLS is enabled, the image will fill the screen with a 16:9 or 1.85 source for 
any output aspect ratio up to 2.40. If the output aspect ratio is greater than 2.40, software limits the 
maximum width to the equivalent of 2.40 and adds left and right sidebars. 

Select the parameter to adjust using the � and � arrows, and change the value of the selected parameter 
using the � and � arrows. The command is: 

MENU → Input → Video Setup → [Resolution] → Size → [Aspect] → NLStretch → OK 

Input Masking 
The masking command allows you to cover up the sides of the video source. It is different then cropping in 
that the video is not stretched to fill the screen. It can be useful for pass-through modes where you do not 
wish the Radiance to scale the picture if there is some video noise on top/bottom/side of the picture that 
you want to cover up. Another situation may be that you wish to cover up and change the gray level of the 
black bars added by a video source, surrounding a letterboxed image. 

When you select the command you must first select which mask number you wish to use. There are 15 
available masks. They can be shared among different input memories. After selecting the mask number you 
then can adjust how much the mask covers of the 4 sides of the input. The last step is to alter the gray 
level for the 4 sides. If an input mask is on, it’s gray level takes precedence over the gray level of the aspect 
bar. The aspect bar gray level can be adjusted under Output->Configs->[Config]->Other->Graybar. Also, if 
aspect bars are requested (via differing input and output aspects) the masking is added to the aspect bar 
width. The command is: 

MENU → Input → Video Setup → [Resolution] → Size → [Aspect ratio] → Masking → OK 

Input Enhancement Controls 
Sharpness 
This command is used to adjust the sharpness for all inputs. There are controls for horizontal, vertical and 
diagonal sharpness (edges) and texture (fine detail).  It is generally best to leave these controls at the 
default setting of 0 or to use moderate settings. Using higher settings can introduce image artifacts.  Some 



 Section 5 – Video Configuration  

RadianceXS  rev 11/17/10  21 

people prefer having all 6 settings set the same. Other people prefer only using the diagonal parameters. 
The command is: 

MENU → Input → Video Setup → [Resolution] → Enhance → Sharpness → OK 

Noise Reduction 
Mosquito noise and block artifact noise are both seen in compressed material. The Radiance has both 
temporal and special noise reduction to help reduce the noise level these artifacts introduce into the image. 
Block artifact reduction is alos supported and can be useful with overly compressed video. The command is: 

MENU → Input → Video Setup → [Resolution] → Enhance → Noise Red. → OK 

Adaptive Contrast 
Adaptive Contrast varies the contrast based on the average level of the central 60% of the picture. When 
you adjust the contrast the effect is shown in a centered window for evaluation. The command format is: 

MENU → Input → Video Setup → [Resolution] → Enhance → AdapContrast → OK 

Copy Enhancement Settings 
You can copy the local enhancement settings to other resolutions and memories. The command is: 

MENU → Input → Video Setup → [Resolution] → Enhance → Copy → OK 



 Section 5 – Video Configuration  

RadianceXS  rev 11/17/10  22 

Miscellaneous Input Controls 
Deinterlacing Mode 
The default deinterlacing mode is “Auto.” This mode automatically switches between video and film 
deinterlacing and is best for mixed-mode sources that change between video and film. For sources that are 
known to be interlaced-video, choosing “Video” deinterlacing mode can improve image quality. For sources 
that are known to be film sources, choosing 'Film' deinterlacing mode can improve image quality. For 60Hz 
interlaced film sources the output must be one of 24, 48, 60, or 72 Hertz, and for 50Hz interlaced sources 
the output rate must be 50 Hertz. For “Film” mode, Sharpness, Noise Reduction and Adaptive Contrast 
settings are not available. The command is: 

MENU → Input → Video Setup → [Resolution] → Control → Deint → Mode→ 
(Auto,Video,Film) 

Inter Frame Motion Detection (IFMD) 
For deinterlacing video sources (not applicable for film) the IFDM control trades-off between minimizing 
combing artifacts (small values) verses maximizing detail (larger values) using the IFMD setting. The default 
setting is 6. This control is most effective with “Video” deinterlacing mode. The command is: 

MENU → Input → Video Setup → [Resolution] → Control → Deint → IFMD→ (0-15) 

Game Mode 
To minimize video processing latency when playing video games, turn “Game Mode” on. Typically game 
mode is enabled for a specific input memory that is then selected while playing games. For games that have 
a vertical rate that matches the Radiance output vertical rate, turning “Genlock” on can further minimize 
video latency. Game mode is not intended for video/film program material, such as television shows. The 
command is: 

MENU → Input → Video Setup → [Resolution] → Control → Game Mode → (On, Off) 

Genlock 
Genlock is used to minimize video delay, for 480i/1080i to 24Hz conversion, and to avoid an occasional 
dropped or repeated frame. It can slow down source and mode changes, so Lumagen recommends setting 
Genlock to ‘off’ for cable and satellite settop boxes. The command is: 

MENU → Input → Video Setup → [Resolution] → Control → Genlock → (Auto, Disabled) 

Deinterlacing Field Flip 
Some source devices do not follow conventions for the order of video fields. This can be seen as excessive 
combing in the video. While generally not required, this command allows the input fields to be swapped so 
these out-of-spec sources can be properly deinterlaced. The command is: 

MENU → Input → Video Setup → [Resolution] → Control → Deint → Field→ (On, Off) 

Input Level 
This command specifies if an analog input has a black pedestal, and if DVI inputs use video levels or PC 
levels. If you are unsure, it is better to leave these at 0 IRE for analog, or PC level for HDMI.  

MENU → Input → (HDMI Setup, Analog Setup) → Level → (Video, PC) 

Input Label 
Each input configuration memory can be named. Follow the on-screen directions. The � and � arrows select 
which input to change and then which character to change. The � and � arrows change the selected 
character. The command is: 

MENU → Input → Label → OK 

Copy Input Settings  
Copy the input setup from the active memory, to the selected memory, or memories. Copying the first input 
memory calibrated to other input memories can speed up the calibration process. Note that copying a SD 
input to a HD input, copies the SD memory to (only) the SD sub-memory of the HD input. The sub-
memories for the other resolutions are not changed. Copying a HD input memory to a SD input memory 
copies the SD sub-memory of the HD input to the SD memory. Copying a HD input memory to another HD 
input memory copies each resolution sub-memory to the respective resolution sub-memory of the other HD 
input. The input copy command copies all user memory parameters to another input or user memory. The 
command is: 

MENU→ Input→ Copy→ OK 
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Section 6 – Audio Configuration 
The RadianceXS supports the HDMI 1.3 audio formats. This means that the Dolby Digital TrueHD™ and DTS 
Master-Audio™ are available. 

By default the audio EDID from the device connected to HDMI Output 1 is passed back to all source 
devices. There are two methods that can be used to change this. Typically the audio menu (MENU → 
Audio) is used to program the audio EDID mode. For most cases the audio menu is all that is needed to 
setup the audio EDID. However, in some cases a specific input, or input memory, may need to use a 
different audio EDID. In this case the audio EDID for each input memory can be changed (MENU → Input 
→ Audio Setup → Audio EDID).   

Introduction to the Audio Menu 
The Audio menu configures the audio EDID reported back to HDMI sources and is independent of the 
Video EDID mode. In addition it selectively enables audio outputs based on the specified conditions. Many 
common system configurations can use the default Audio mode settings. Some examples of these are: 

• HDMI television connected to HDMI Out 1 
• HDMI receiver connected to HDMI Out 1 and (non-audio) display connected to HDMI Out 2 
• HDMI receiver connected to HDMI Out 1 with a display connected to the receiver’s HDMI output 
• SPDIF receiver connected to COAX Audio Out and (non-audio) display connected to HDMI Out 2. 

NOTE: 
Associating an audio input with a video input is done using the Input menu 

MENU → Input → Audio Setup → Source → (audio input) → OK. 

NOTE:  
For best switching, and power-on, times manually select the output resolution and select “USER1 EDID” 
for the audio mode. For example, for a 1080p60 display pressing MENU 0 2 7 OK selects 1080p60 and 

eliminates the need for the Radiance to read the display video EDID. Selecting “Always”, and “USER1 EDID” 
in the Audio menu eliminates the need for the Radiance to read the audio EDID information from the 
AVR/TV. See the Output Configuration Commands section, and Audio section, for more information. 

Remember to save any changes. 

NOTE: 
When using the COAX SPDIF audio output, audio EDID should  

be set to “Always USER1 EDID” in the main audio menu. 

Some important concepts for selecting the audio configuration are: 

• Audio from any audio input (HDMI, SPDIF, analog) can be routed to one or both of the HDMI 
outputs, and/or the two COAX outputs, with the appropriate limits on the output format. For 
example, the digital COAX audio output can only carry 2-channel PCM, Dolby Digital, and DTS. 

• HDMI audio EDID reported back to the HDMI sources can be passed-back from either of the two 
HDMI outputs, passed back from the common elements of the two outputs (i.e. only features 
supported by both outputs are enabled), or specified by the user (User EDID).  

• The audio EDID reported back to sources can change dynamically, as configured by the user, 
based on which HDMI output has active video. NOTE: Some sources update their EDID 
information only when they are powered on, or do not properly reread EDID when the HDMI 
Hotplug signal is toggled. If you have a source that reads EDID only at power-on, or does not 
respond properly to Hotplug, a single EDID mode should be enabled (e.g. select “always report 
user EDID” as described below). 

• Selecting “User EDID” is the recommended practice. This allows the Radiance to report the EDID 
back to the HDMI sources even when the display or receiver is turned off. This can also 
significantly shorten the system boot time. 

• Default “User EDID” mode is 2-channel PCM and Dolby-Digital 5.1 only. The user can change the 
“User EDID” to include any audio modes supported by the Radiance and the audio processor. 

• Audio EDID, and audio output enables, are global parameters. That is, they change (only) when 
the active output changes. NOTE: The Audio EDID mode is independent of the Video EDID mode. 
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• You can over-ride the global Audio EDID for a particular HDMI input by selecting MENU → Input → 
Audio Setup → Audio EDID → Custom → Ok. Set the audio modes to “Y” (yes) that you want to 
report back the source for that input. 

• Audio is muted when changes are detected on the input. Some audio receivers need to be muted 
longer to avoid unintended noise. MENU → Input → Audio Setup → Mute Control → Long → Ok 

Audio Menu Navigation 
You can change the setting for any item in the Audio menu by first navigating to the item using the 
remote’s arrow buttons and then pressing the “OK” button. The item will begin flashing to indicate it is 
active for change. Use the arrow buttons to change the setting. Press the “OK” button to accept the setting 
or the “EXIT” button to cancel. The highlight will stop flashing and a new item can be selected. 

Audio Menu Selections 
Each line of the audio menu can have up to 6 entries. These are: 

Conditional Audio EDID to Report User Mode Select  HDMI1 HDMI2 SPDIF 
Always 
If Out1 video on 
If Out2 video on 
Else 

Merged Out1&Out2 EDID 
Out1 EDID 
Out2 EDID 
User1 EDID 
User2 EDID 
User3 EDID 
 

PCM 2Ch 44.1Khz 
PCM 2Ch 48Khz 
PCM 2Ch 96Khz 
PCM 5.1 44.1Khz 
PCM 5.1 48Khz 
PCM 5.1 96Khz 
DD 5.1Ch 
DD 7.1Ch 
DTS 5.1Ch 
DTS 7.1Ch 
DD HD 5.1Ch    
DTS HD 5.1Ch  

Y 
Y 
Y 
N 
N 
N 
Y 
N 
N 
N 
N 
N 

On 
Off 

On 
Off 

On 
Off 

Audio Menu Structure 
Audio setup is global using an “If – Then – Else” structure based on which HDMI output has active video. In 
contrast, the video EDID is selected in the input memory “EDID Setup” on a “per-input-memory” basis, and 
the audio EDID is globally selected based on which HDMI output has active video. The net effect of this 
method is that the video EDID capability can be passed back from one of the HDMI outputs (or user 
defined) and the audio EDID capability can be passed back from the same HDMI output, the other HDMI 
output (or user defined). 

NOTE: 
By default, Output 1 has both video and audio enabled, and Output 2 has only video enabled. So, the 

default configuration for a system with an AVR and a projector is that the AVR is connected to Output1 and 
the projector is connected to Output 2. Examples below illustrate how to change this if desired. 

 

The “If” Conditional 

The first parameter on each command line can be an “Always” clause, an “If” conditional, or an “Else” 
clause. If there is more than one line, the last line will always contain an “Else” clause. The “Always” or 
“Else” clauses do not have conditionals. There are two options for an “If” conditional: 

• If Output 1 is enabled for video output 
• If Output 2 is enabled for video output 

The “then” Clause 

The second parameter is the “then” clause. If the “If” conditional is true the “Then” clause is used, 
otherwise control is passed to the next command line. The options are: 

• User Defined 
• Pass-through audio EDID from Output 1 
• Pass-through audio EDID from Output 2 
• Pass-through the common audio modes from Output 1 and Output 2 

Audio Example 1 (Default Audio Configuration) 

Output 1 drives a receiver that has audio capability. Output 2 drives a display that doesn’t have audio 
capability. This is the default case, and can be set as shown: 
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Else

If Out1
video on

Condition uses Audio EDID

 On        Off        On

 On        Off        On

Audio Outputs
HDMI1  HDMI2  SPDIF

 Out1 EDID

 User EDID PCM 2Ch 48Khz       Y

 

• If output 1 is enabled for video output, and it’s EDID shows that it has audio capability, then pass 
it’s audio EDID back to the HDMI sources. 

• If this is not true, then set the EDID to the audio formats selected by the user. 

Because an HDMI device should not output audio to a particular output if it is beyond the capability of the 
device attached to that output, each line has a user selectable field to independently enable each audio 
output. These fields cover HDMI output 1, HDMI output 2 and the digital COAX audio outputs. So the 
default case has HDMI output 1 and COAX audio turned on. You should change the settings of the User 
EDID to match your system. 

Audio Example 2 
A single line case with “User EDID” is shown below. 

When you set the audio EDID to “User EDID,” a “User EDID settings” menu is shown (this is the “PCM 2 Ch 
48KHz   Y” entry below). You can use the “User EDID settings” menu to select which audio modes will be 
advertised by the audio EDID. By default 2-channel PCM and DD 5.1 modes are enabled. Other modes must 
be enabled using the menu commands. 

 

Audio Example 3 
Output 1 drives a projector, which doesn’t have audio capability (or it’s not used) and instead the COAX 
audio output is used. Output 2 drives a second display, which has audio capability and uses HDMI audio. 
When the second output is used, the video configuration is set to enable output2, and disable output 1. This 
type of setup might have the two displays in different rooms with different equipment. This can be set as: 

 

Audio Example 4 
Output 1 drives a 1080p60 HDMI projector without audio capability, and output 2 drives an HDMI amp. In 
addition, the amp’s HDMI output drives a 720p (max) LCD TV. When watching the projector (1080p60), 
Output 2 should have audio only since the TV cannot accept 1080p60. When you watch TV you would select 
720p video output, and turn on the video output on HDMI Output 2. One option is to set MEMA to output 
1080p (and disable output 2 video), and MEMB to output 720p on both outputs. Audio can be set as: 

 

Audio User EDID 
When selecting specific audio modes, the up and down arrow keys select an entry and the right arrow key is 
used to turn that mode on or off. 
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Input Memory Specific Audio EDID 
If an input, or input memory, requires a specific EDID, it can be configured by the MENU → Input → 
Audio Setup → Audio EDID menu. Each input memory can be configured to use the global audio EDID, 
or a specific list of audio modes to report back to the source. 

Audio Source Selection Defaults 

To change the audio source for a particular input, first select that video input, and then select the desired 
audio source. Any number of video inputs can be linked to the same audio source. The command is: 

 MENU → Input → Audio Setup → Source → (select audio input) → OK 

The video inputs are linked to the following audio sources by default.  

Input 
Number 

Video Input 
Type 

Audio 
source 

Input 
Number 

Video Input 
Type 

Audio 
source 

1 HDMI HDMI1 10 Component COAX3 
2 HDMI HDMI2 11 S-Video TOS2 
3 HDMI HDMI3 12 S-Video COAX4 
4 HDMI HDMI4 13 S-Video COAX5 
5 HDMI HDMI5 14 S-Video COAX6 
6 HDMI HDMI6 15 Composite STEREO1 
7 Component TOS1 16 Composite STEREO2 
8 Component COAX1 17 Composite STEREO3 
9 Component COAX2 18 Composite STEREO4 
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Section 7 - Calibration 
Your theater system needs to be calibrated. To brighten the image in the show room, most display 
manufacturers intentionally change the display calibration away from industry standards. Unfortunately most 
displays do not have the controls necessary to undo these errors. Correcting these intentional errors, and 
other unintentional errors, so the image appears as the producers intended, is a primary function of the 
Radiance. The Radiance has a host of features dedicated to this task. 

It is recommended that a professional calibrator be hired to perform the calibration. An experienced 
professional calibrator has the necessary tools and experience to extract the best performance from your 
theater. However, you can improve your picture without hiring a professional if you prefer. You will need to 
learn how to use the Lumagen test patterns, and have either a test-pattern generator or a calibration disc 
(such as AVIA or Digital Video Essentials). Then you need to spend time learning how various calibration 
controls interact and how they affect image quality. 

To understand Radiance calibration, it is important to note that setup and calibration parameters are split 
into “input memories” and “output configurations.” Input memories are for source specific setup and 
calibration. Output configurations deal with display setup and calibration. These are covered elsewhere in 
this manual. 

It is recommended that the internal Lumagen test patterns be used to calibrate the output configuration. 
This will assure that any variance between sources (size, color or levels) do not affect the calibration of the 
display. Note that some professional calibrators prefer to use a test pattern generator for all calibration 
functions. This method can also work well. After the display has been calibrated, differences between inputs 
can be calibrated using test patterns played on the source devices or test pattern generators. 

The recommended Lumagen calibration sequence is shown below. 

Set the display’s picture controls to neutral 
• Disable enhancement features on the display. Features such as sharpness, DRC and certain color 

mode settings do not live up to their advertising and can actually reduce image quality. In addition 
the Lumagen enhancement features work best when the display is set to have it’s own 
enhancement features disabled. 

• Select the display color temperature setting that is closest to the “D65” for white. This is often 
referred to as “D65,” “warm,” or “cinema” color mode, but this varies between manufacturers.  

Calibrate black and white levels using display controls 

• To calibrate the black and white levels in the display, select the Lumagen contrast test pattern. Use 
the right-arrow key to select the Contrast 1 (or Contrast 2) test pattern. The Contrast 1 pattern has 
two white rectangles and two black rectangles. In the dark areas, there are two vertical bars, one 
at 4 IRE and one at –4 IRE. The white area has two vertical bars, one at 96 IRE and one at 104 
IRE. Note that 0 IRE is reference black and 100 IRE is reference white. Since –4 and 104 are 
outside the nominal black to white range, not all displays will show these levels. The test pattern 
command is: 

 MENU → Other → Test Pattern → Reference → OK 

• Adjust the black level using the display’s brightness control.  Adjust so that the 4 IRE bar is barely 
visible against the black background (0 IRE). There should be no visible difference between the 
black background areas and the –4 IRE bar. This is a secondary indication verses the 4 IRE bar, 
but can be useful in optimizing the black level in displays that support blacker-than-black. 

• Adjust the white level using the display’s contrast control. Adjust so that the 96 IRE bar is still 
visible against the white (100 IRE) background. If a display supports whiter-than-white, the 104 
IRE bar may be visible. This is not a requirement, but does show if there is headroom above white. 

• Check your results with a realistic image. Some displays can be adjusted so that the 96 IRE bar is 
visible but the image does not look it’s best due to a too-high contrast setting. In this case adjust 
the display’s contrast control to reduce the maximum brightness until the video image looks good. 

• If either the 4 IRE and/or 96 IRE bars cannot be made visible after adjusting the controls, check 
that the appropriate Lumagen output level (Video or PC) has been selected. The command is: 

 MENU → Output → Configs → [Config] → HDMI Format → Type → (PC, Video)  
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Color Management 
The Radiance Color Management System (CMS) controls are used to calibrate display grayscale tracking, 
gamma plus primary, and secondary, colors. The use of these controls requires advanced knowledge and 
special equipment. We suggest that a qualified video technician be hired to do this calibration. 

Calibrate 100 IRE white to D65 using the display’s controls 

• Note that Lumagen recommends that a qualified video technician be hired to calibrate grayscale. 

• It is best to calibrate the 100% white point color-of-gray in the display when possible. If the 
display has a custom grayscale control, calibrate the 100% white point as described below. 
Otherwise skip this step. 

• To calibrate the 100 IRE color-temperature point using the display’s controls, select the Lumagen 
100 IRE window test pattern. This pattern has a white window on a black background. Navigate to 
the Lumagen test pattern menu and then use the right-arrow key to select the 100 IRE Window 
test-pattern. The command is: 

 MENU → Other → Test Pattern → Reference → OK 

• Adjust the color temperature of 100% white to D65 using the display custom grayscale calibration 
controls. Note that, if the color gamut is to be calibrated, the selected color temperature in the 
display should be one where the red, green and blue primaries are outside the CIE color triangle 
for the desired color space.  

• If the display 100% White Point cannot be calibrated, select a “Color Mode” in the display that 
gives a result for the 100% White Point that is close to the D65 specification. The use the Radiance 
CMS “White” calibration to adjust the 100% White Point. 

• Some high-end displays have advanced calibration menus. An experienced calibrator may choose 
to use some these features to do additional calibration before calibration is completed using 
Lumagen controls. 

Calibrate Radiance primary color gamut 
• Many digital displays have over-saturated primaries. The Radiance CMS controls allow the 

characteristics of the primary and secondary colors to be corrected. Note that the primary colors 
can only be repositioned within the triangle that is defined by the position of the display’s 
uncorrected primary colors. If a display has under saturated primary points (such as on typical CRT 
based displays) they cannot be corrected. 

• Note that if needed in the Radiance, the 100% white point should be adjusted using the gamut 
white-point calibration rather than the grayscale calibration menu. 

• The Radiance menu mode must be set to “Service mode” to make changes. The command is: 

 MENU → Other → Menu mode → Service mode → OK 

• The gamut calibration command usage is described in a Tech Tip on the Lumagen support web 
page. The command is: 

 MENU → Output → Configs  → [Config] → Color Mgmt→ Color Gamut → OK 

Calibrate Radiance grayscale and gamma 

• Grayscale and gamma should be calibrated at this point. Calibrating these parameters is an 
essential part of the video calibration process. The display should have been set to a color 
temperature close to D65, and the 100 IRE white point should be calibrated using the display 
controls or the Radiance gamut white-point, if feasible. Then the Lumagen parametric grayscale 
controls should be used to calibrate the other gray levels. 

• Grayscale calibration adjusts the “color of gray” so that the color “gray” adheres to industry 
standards (D65 point for color images), at all levels from black to white. The command is: 

 MENU → Output → Configs →  [Config] → Color Mgmt→ Gray/Gamma → OK 

• Gamma is the response curve between black and white and also has an industry defined standard 
that should be followed. Lumagen has developed a unique 2,5,11,12 or 21 point parametric 
grayscale/gamma calibration feature, which allows both grayscale and gamma to be optimized over 
the entire range from black to white, and not just at one or two points. The command is: 

 MENU → Output → Configs →  [Configs] → Color Mgmt→ Gray/Gamma → OK 
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• After completing the output calibration, copy the results to all configuration memories. The 
command is: 

 MENU → Output → Copy → OK 

• It is a good idea to save the configuration before proceeding. The command is: 

 MENU → Save  → Ok → OK → OK 

Iterate the gamut and grayscale/gamma calibrations 
• Since the gamut and grayscale/gamma calibrations interact to some degree, it is important to 

repeat both until good results for both are achieved. Note that the following step, color/hue, also 
interacts with these controls.  

Calibrate Radiance output color and hue 

• If gamut, grayscale/gamma have been calibrated using a color probe, or spectral radiometer, and 
the display suffers from red-push, green-push, or blue-push, the Output Configuration color and 
hue controls can be used to correct the resulting errors in flesh tones.  

• If no gamut or grayscale calibration has been done, color and hue, and color/hue offsets can still 
be used to improve color fidelity using colorbar patterns and color filters. It should be noted that 
color filters are not ideal and so whenever possible gamut, grayscale/gamma and color/hue should 
be calibrated using a color probe or a spectral radiometer as noted above. Set the Color (Color) 
and Hue (Hue) controls in the Radiance output menu using a colorbar pattern and a blue filter. 
The procedure used to accomplish this is described on DVD test discs such as AVIA. Next set the 
red color (Color Red) and Hue (Hue Red) offsets using a red colorbar pattern and a red filter. 
Finally set the green color (Color Green) and Hue (Hue Green) offsets using a green colorbar 
pattern and a green filter. Set the menu mode to “service mode,” select Radiance color-bar pattern 
with the menu command. While the pattern is displayed, pressing menu leaves the pattern up and 
directly selects the color/hue menu. The command is: 

 MENU → Other → Test Pattern → Adjustable → [select pattern] → OK 
 MENU → Output → Configs → [Config] → Color Mgmt → ColorDecoder → OK 

Iterate gamut, grayscale/gamma and color/hue calibrations. 
• Since the gamut, grayscale/gamma, and color/hue calibrations interact to some degree, it is 

important to repeat all three steps until good results for both are achieved.  

Calibrate Radiance input overscan, black, white, color and hue 

• The Lumagen provides four independent input configuration memories for each input. Calibration 
for each input is independent of the other inputs and multiple independent calibrations can be 
done for each input. One use for the multiple calibrations for each input is to calibrate MEMA for 
day and MEMB for night viewing. Also, each input memory has separate calibrations for each of 
eight input resolutions [See the Memory Configuration section]. Typically the DVD, or Bluray, input 
is calibrated first, using a DVD, or Bluray, calibration disc, or you can connect a video test pattern 
generator. Then the results of this calibration are then copied to all input memories as a reference 
starting point for the other sources. However, any source can be calibrated first if you prefer. 

• Set the Lumagen input aspect ratio as 4:3 (1.33) for a 4:3 screen, 16:9 (1.76) for a 16:9 screen, 
or 2.35 for a projector with a 2.35 anamorphic lens. The input aspect ratio should be set before 
adjusting the overscan. 

• Display an “Overscan” test pattern from the selected source. 

• Adjust the input size and position. This selects which pixels are captured. Adjust the top-left corner 
of the image first. Then adjust the bottom-right corner. For digital 1080i/p 16:9 sources input size 
should only be adjusted if absolutely necessary for 1080p 16:9 screens, so that the scaling will 
remain off, which in turn will keep the image as sharp as possible. The command is: 

MENU→ Input→ Video Setup→ [Resolution]→ Size→ [Aspect]→ (Crop TopLeft,                
Crop BotRGHT) 

• Display a “contrast” or a “Needle Pulses” test pattern. 

• Set the black level. Since the Lumagen-to-display levels were set above in the Output Calibration 
section, the Lumagen internal input-memory Black level control should be used. This allows 
differences between sources to be corrected. Note that many cable and satellite services use 
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different black levels for standard definition and high-definition sources. Using a Radiance is one of 
the few ways you can correct this error. It is recommended that you use a low average picture 
level test pattern, which has a black frame with two moving bars (2 and 4 IRE) for setting black 
level. The reason is that the black level varies with the average intensity on the screen for many 
displays. Since the black level is most critical in dark scenes this will provide the best setting. The 
command is: 

 MENU→ Input→ Video Setup→ [Resolution]→ Picture → Black → OK 

• Set the white level (contrast). Since the Lumagen-to-display levels were set above in the Output 
Calibration section, the Lumagen internal input-memory Contrast control should be used. The 
command is: 

 MENU→ Input→ Video Setup→ [Resolution]→ Picture→ White → OK 

• Display a “Colorbar” test pattern, sometimes referred to as an “SMPTE bar” test pattern. 

• Set Color and Hue and then the Color and Hue offsets for red and green. The display’s Color and 
Hue should have been set to default before performing any calibration steps. First set Color and 
Hue using the blue colorbar pattern and the blue filter. Next set the red color (Color Red) and 
Hue (Hue Red) offsets using the red colorbar pattern and the red filter. Finally set the green color 
(Color Green) and Hue (Hue Green) offsets using the green colorbar pattern and the green 
filter. The command is: 

MENU→ Input→ Video Setup→ [Resolution]→ Picture→ ColorDecoder → OK 

• Display a “Y/C Delay” test pattern. 

• Set Y/C Delay. Use the Lumagen Control to minimize the error in the blue and red timing verses 
Luma. The CB and CR channels are calibrated independently. 
 MENU → Input → [Resolution] → Picture → YC Delay → OK 

• You may wish to copy the calibrated configuration to all configuration memories as a starting point. 
  MENU → Input → Copy → OK 

• If desired, change to MEMB and repeat the above steps to calibrate for a different amount of room 
light.  

• Calibrate the other inputs. 

• Name the inputs, if desired. The command is: 

   MENU → Input → Label → OK 

• Lock the configuration, if desired. The command is: 

  MENU → Other → Menu Mode→ Locked → OK 

• SAVE THE CONFIGURATION 

  MENU → Save → Ok→ OK→ OK
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Section 8 – Miscellaneous Commands 

System Settings 

Menu Mode 
The menu mode controls what settings can be changed in the menu. In Locked mode nothing can be 
changed in User Mode, Service Mode (temporary) and Service Mode (permanent).  The default setting is 
User Mode, which allows access to all the basic controls. The Service Mode allows access to all controls 
including the color gamut controls. The configuration can be locked to prevent unintended changes. When 
locked, input selection functions normally, but setup parameters are fixed. The command is: 

MENU → Other → Menu control→ Menu Mode → (Locked, User mode, Service mode 
temporary, Service mode permanent)  

Menu Timeout 
In the “Normal” setting the menu will timeout in approximately three minutes. The “Slow” setting extends 
the menu timeout by x10. This also controls the length of time test patters are displayed. The command is: 

MENU  0  9  0  5 (Normal, Slow) Ok 

or MENU → Other → Menu control→ Menu timeout → (Normal, Slow)  

OSD Enable 
Enable or disable On-Screen-Display (OSD) activation after user commands. If enabled, the OSD shows the 
selected input, input aspect ratio, and zoom. The command is: 

MENU → Other → Menu control→ OSD enable → (On, Off) 

Input Reselect 
If this is set to “On”, then when the currently active input is reselected the input will be reinitialized and the 
input number will be displayed. The command is: 

MENU → Other → Menu control→ In Reselect → (On, Off) 

Quick Keys 
This adds an optional top-level menu called “Quick Keys” that gives access to functions that are normally 
selected using buttons on the Lumagen remote. This menu can be used with programmable remotes that 
have limited buttons. You can use the arrow buttons on the remote to highlight one of the functions and 
press “Ok” to execute the function. Alternately you can use a number button on the remote to highlight one 
of the functions and then press “Ok” to execute the function. (0)4:3, (1)LBOX, (2)16:9, (3)1.85, (4)2.35, 
(5)NLS), (6)Zoom+, (7)Zoom-), (8)MemA, (9)MemB, (n/a)MemC, (n/a)MemD) The command is: 

MENU → Other → Menu control→ Menu Options → Quick Keys → (On, Off) 

MENU → Quick Keys <optional top-level menu> 

Menu Placement 
In the “Standard” placement the menu is in the center of the screen. Choose “Center open” to move the 
menu so that the center of the screen is open for display calibration measurements. The command is: 

MENU → Other → Menu control→ OSD enable → Menu placement → (Standard, Center 
open) 

Initial Power State 
When power is first connected, the unit can be set to turn on automatically, or it can be set to start in 
standby-mode. The command is: 

MENU → Other → OnOff Setup → Auto On → (Standby, Turn On) 
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Initial Input State 
This sets which input and input memory is selected when unit is turned on, either after power has been 
removed or the unit has been put into standby. The command is: 

MENU → Other → OnOff Setup → Input Select 

On/Off Message 
A programmable string can be sent to another device via the RS-232 connector to turn the device on or off. 
The command is: 

MENU → Other → OnOff Setup → (On Message, Off Message) 

Message Control 
This sets the RS-232 parameters that are used for sending a power on/off message to another device. The 
command is: 

MENU → Other → OnOff Setup → Message Ctl 

Test Patterns 
Warning: 

Test patterns can burn plasma and CRT displays if left on for more then a few seconds. 

The user can select from a large selection of test patterns. While in the test pattern menu the � and � 
arrows select a test pattern group. Press the “4” button to step though the test patterns in a group. For 
many test patterns the intensity can be adjusted from 0 to 100 IRE, in 5 IRE steps, using the � and � 
arrows. Reference test patterns are only affected by the output PC/Video level setting. Adjustable patterns 
allow viewing the effect of the output color management settings. The Warm Up test pattern displays a 20 
IRE to 50 IRE gray screen.  

To exit the test pattern command but leave the pattern on-screen, press “OK”. You can then adjust various 
parameters to judge their effect on the pattern. Press “Prev” to then toggle between the source and the 
pattern. Press “Alt” to jump back into the pattern command. The “Prev” and “Alt” functions are only valid if 
leave the pattern on-screen by pressing “Ok”. The command is: 

MENU → Other → Test Pattern→ Pattern → (Reference, Adjustable, Warm up) 

Trigger Out 
This command controls the two trigger outputs on the rear panel. By default Trigger 1 is on for when power 
is on, and Trigger 2 is on when the input aspect ratio is selected as 2.35 aspect. There is a setting to control 
the trigger with RS-232 commands. The command is: 

MENU → Other → Trigger Out→ (Trigger1, Trigger2), (On at Power-up, Under RS232 
control, Off at Power-up, Off if 2.35 aspect, On if 2.35 input aspect, Off if 4:3 aspect, 
On if 4:3 input aspect) 

Remote Control 
Allows changing the default command usage of the arrow buttons on the remote. By default the Up/Down 
arrow buttons can be used to control zoom. The Right/Left arrow buttons can be used to select the input 
aspect ratio. You can turn off these additional functions by selecting “Off”. The command is: 

MENU → Other → Remote Ctl → (Up/Down arrows, Rt/Left arrows) → (On, Off) 

Zoom Step 
This command sets the size of the Zoom step to 5% or 15%. The command is: 

MENU → Other → Zoom step → (5%, 15%) 

LED Setup 
This command controls the operation of the Green LED on the front panel. The LED can be set to “Green” to 
be a power on indicator or set to “Dark” so that it is off when the Radiance is operating. The command is: 

MENU → Other → LED Setup → (Green, Dark) 
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RS-232 Setup 
With echo on the Radiance will echo all characters sent to it. With echo off the Radiance will only send a 
message at power on/off. With echo set to off with status, the power on/off messages are changed to 
status responses. See Tech Tip 11 for delimiter usage and more details. The command is: 

MENU → Other → Zoom step → (Echo, Delimiters) → (On, Off) 

Configuration Memory Usage 
By default, when a configuration memory (A-D) is chosen the selection applies to all inputs. For example if 
input 1A is active, then input 2 is selected followed by selecting “MemB,” if input 1 is again selected, it 
would use configuration memory 1B. This is called the “Common” configuration memory mode. Generally 
this mode is used when specific day and night calibrations are desired and used for all inputs. 

You can set the memory usage to be “Per Input.” That is the configuration memory selection is independent 
for each input. In this mode, using the example above, starting with input 1A, changing to input 2, pressing 
“MemB” and finally selecting input 1, results in using configuration memory 1A. 
The command is: 

MENU → Other → Memory Usage → (Common, Per Input) 

Saving the Configuration 

Save 
NOTE:  

If a Save command is not executed after making changes, the changes will be 
lost when the unit is put into standby power mode, or if power is interrupted. 

Permanently save the current configuration. Note that, once saved, the configuration is retained even if the 
unit is disconnected from power. The configuration from the previous save is retained to allow one level of 
save-undo. You can use the Radiance Configuration Utility to store a configuration file on your PC. The 
command is: 

MENU → Save → Save → OK 

Undo 
Revert to the configuration over-written by the last Save command. Repeating the Save Undo command 
toggles between the last two saved configurations. The command is: 

MENU → Save → Undo → OK 

Restore ISF calibration 
During calibration, the video technician can save the resulting Lumagen configuration to a special hidden 
configuration memory. This command restores that configuration in the event that the user inadvertently 
changes the configuration. A Save is required to make the restore permanent. The command is: 

MENU → Save→ Restore ISF→ OK 

Revert To Factory Settings 
Set all parameters to factory defaults. A SAVE is required to make the settings permanent. The command 
is: 

MENU 0 9 9 9 

Or MENU → Save→ FactoryReset → OK 
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Section 9 – Command Interface 

Direct Commands 
Direct Commands are entered by using the Lumagen remote control. All of these commands can also be 
entered by using the RS232 interface. 

Output Vertical Resolution 
 480p:    MENU  0  2  1    Progressive with 480 active scanlines 
 540p:    MENU  0  2  2    Progressive with 540 active scanlines 
 720p:    MENU  0  2  4    Progressive with 720 active scanlines 
 768p:    MENU  0  2  5    Progressive with 768 active scanlines 
 1080p:    MENU  0  2  7    Progressive with 1080 active scanlines 
 1080i:    MENU  0  2  8    Interlaced with 1080 active scanlines 

Output Vertical Rate 
 Set vertical rate:  MENU  0  4  (50Hz, 60Hz)  OK 

Output Miscellaneous 
 Out PLL Clock   MENU  0  9  3  3    Output PLL clock frequency. Use with caution. 

Output Aspect Ratio 
 Output aspect ratio: MENU  0  6  value  OK  Example: For 16:9 enter178 

Miscellaneous Commands 
 S/W Rev     MENU  0  9  0  3  Display software revision and serial-number 
 Menu timeout  MENU  0  9  0  5  Toggle menu timeout. Short (default) or long (saved) 
 Service Mode   MENU  0  9  1  0  Toggle SERVICE MODE. (not saved) 
 Unlock menu   MENU  0  9  1  5  Can also be selected using menu  
 Output defaults   MENU  0  9  9  8  Reset current output to default for current resolution 
 Factory defaults   MENU  0  9  9  9  Reset to factory default (Must “Save” to make permanent) 
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IR Command Interface 

IR Command List 
Remote 
Command IR-binary 

IR-
HEX Description 

ON 0010 00 0001 11 207 Power on 

STBY 0010 00 0010 11 20B Power to standby 

MENU 0010 00 0111 11 21F Activate menu 

EXIT 0010 10 1001 11 2A7 Exit. Often acts as a cancel key 

CLR 0010 00 1001 10 226 Force menu off (i.e. can use to assure menu is off for input selection) 

INPUT 0010 10 1010 00 2A8 Choose input 

ZONE 0010 10 0111 10 29E Output zone select 

ALT 0010 00 0111 00 21C Alternate 

PREV 0010 10 0110 11 29B Display previous input 

PIP-OFF 0010 10 1010 00 2A8 PIP off 

PIP-SEL 0010 00 1010 01 229 PIP select 

PIP-SWAP 0010 00 1010 10 22A PIP swap 

PIP-MODE 0010 10 1010 11 2AB PIP mode 

OK 0010 10 1000 01 2A1 Accept command 

< 0010 00 1000 00 220 Left arrow  

> 0010 10 1000 10 2A2 Right arrow  

v 0010 00 1001 01 225 Down arrow  

 ̂ 0010 10 0111 01 29D Up arrow  

0 0010 00 0101 01 215 Enter the digit 0 

1 0010 10 0011 00 28C Enter the digit 1 

2 0010 00 0011 01 20D Enter the digit 2 

3 0010 00 0011 10 20E Enter the digit 3 

4 0010 10 0011 11 28F Enter the digit 4 

5 0010 00 0100 00 210 Enter the digit 5 

6 0010 10 0100 01 291 Enter the digit 6 

7 0010 10 0100 10 292 Enter the digit 7 

8 0010 00 0100 11 213 Enter the digit 8 

9 0010 10 0101 00 294 Enter the digit 9 

4:3 0010 00 0010 00 208 Input is 4:3 format. Use previous zoom setting. 

4:3NZ 0010 10 1111 00 2BC Input is 4:3 format. No zoom. 

LBOX 0010 10 0010 01 289 Input is 4:3 letterbox format. Use previous zoom setting. 

LBOXNZ 0010 00 1111 01 23D Input is 4:3 letterbox format. No zoom 

16:9 0010 10 0010 10 28A Enhanced for 16:9 televisions format. Use previous zoom setting. 

16:9NZ 0010 00 1111 10 23E Enhanced for 16:9 televisions format. No zoom. 

1.85 0010 00 0001 00 204 Input is 1.85 format. Use previous zoom setting. 

1.85NZ 0010 10 1111 11 2BF Input is 1.85 format. No zoom. 

2.35 0010 10 0001 01 285 Input is 2.35 format. Use previous zoom setting. 

MEMA 0010 00 0101 10 216 Select MEMA 
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Remote 
Command IR-binary 

IR-
HEX Description 

MEMB 0010 10 0101 11 297 Select MEMB 

MEMC 0010 10 0110 00 298 Select MEMC 

MEMD 0010 00 0110 01 219 Select MEMD 

+10 0010 00 0110 10 21A Add 10 to the next digit entered 

FREEZE 0010 10 1001 00 2A4 Freeze-frame. Any other character resumes 

YPRPB 0010 00 1011 00 22C Output type is HD color-space YPbPr (component) 

RGBHV 0010 10 1011 01 2AD Output type is RGBHV. <enter> completes command 

RGBS 0010 10 1011 10 2AE Output type is RGBS. <enter> completes command 

RGsB 0010 00 1011 11 22F Output type is RGsB. <enter> completes command 

480P 0010 10 1100 00 2B0 Select Vertical Resolution = 480p 

540P 0010 00 1100 01 231 Select Vertical Resolution = 540p 

600P 0010 00 1100 10 232 Select Vertical Resolution = 600p 

720P 0010 10 1100 11 2B3 Select Vertical Resolution = 720p 

768P 0010 00 1101 00 234 Select Vertical Resolution = 768p 

840P 0010 10 1101 01 2B5 Select Vertical Resolution = 840p 

1080P 0010 10 1101 10 2B6 Select Vertical Resolution = 1080p 

1080I 0010 00 1101 11 237 Select Vertical Resolution = 1080I 

ASPECT 0010 00 1110 11 23B Set Output aspect ratio  

 

Serial RS232 Command Interface 

Usage 
The RS232 serial interface can be used to control the operation of the Radiance or allow the Radiance 
to do some simple control of another device. To connect the Radiance to a PC, or another device, use a 
standard RS232 null modem cable. 

There are some commands that require a carriage return and they are listed with a “<CR>” at the end. 
You can use a carriage return or “{“ as a command terminator. Any character outside the legal range 
for characters, Hex 20 to Hex 7A will act as a terminator. Characters above Hex 7F are masked off with 
“x7F”. Adding a carriage return to the commands that don’t require a carriage return may result in a 
menu being left on the screen. 

All commands to query the status of the Radiance begin with "ZQ", followed by another character 
(currently 'I','S','O'), followed by a 2 digit decimal code. No terminating characters are used with the 
query commands 

The query response always begins with '!' followed by the last 3 characters of the query request, 
followed by the data for the query using commas to separate, followed by “<CR><LF>”. 

Port Settings 
• 9600 Baud 
• 8 data bits 
• No parity bit 
• One stop bit 

RS232 Connections 
 Pin 2 – Receive 
 Pin 3 – Transmit 
 Pin 5 and connector shell – Ground 



Section 9 – Command Interface 

RadianceXS  rev 11/17/10  37 

RS-232 Power OnMessage/OffMessage 
Power On/Off Message that can be used to control another device. Can be used to send an ASCII string 
out the RS-232 port to turn on or off a display. NOTE: Turning “On” RS-232 power  

OnMessage/OffMessage in the Radiance menu, turns off echoing of the original query command. The 
query response will still be sent. The command is: 

 MENU → Other → OnOff Setup→ (On Message, Off Message) 

Message Control 
Set baud rate, parity and gap for the Power On/Off Message. The command is: 

 MENU → Other → OnOff Setup→ Message Ctl 

On Screen Display Message 
Turn On/Off the input display window that is shown at the bottom of the screen when you change 
inputs. If you use a control system to change inputs on the Radiance you can set OSD enable to “Off”. 
The command is:   

 MENU → Other → Menu Control→ OSD enable  

Echo command 
When Echo is set to “Off”, the Radiance will only send a message at power on/off. 

When Echo is set to “Off with Status”, the status for power or input changes are in the same format as 
the response to status query commands ZQS02 or ZQI00. 

When Echo is set to “On”, the Radiance will echo all characters sent to it. 

Also see the “ZE” command. 
 
The command is:   

 MENU → Other → RS-232 Setup→ Echo→ (Off, Off with Status, On) 

Optional start/end delimiters for RS232 commands 
When Delimiters is set to “On” or “On with Ack/Nack”, the Radiance accepts RS232 commands in the 
format “#<command><CR>”. Start is '#'. End is <CR> or a terminator. Any character outside the legal 
range for characters, Hex 20 to Hex 7A will act as a terminator. Characters above Hex 7F are masked 
off with “x7F”. Commands that already end with a <CR> do not need a second <CR>. 

When Delimiters is set to “On with Ack/Nack”, an ack or nack will be given per command. Ack = "!Y", 
Nack="!N". An ack is given when a '#",<CR> pair is seen with at least one character in between. A 
nack is generated if unmatched start/end delimiters are seen or if a '#',<CR> pair is sent with nothing 
in between. The ack does not indicate whether the character(s) in between '#',<CR> represented a 
valid command. 

When Delimiters is set to "On with Csum & Ack/Nack" the Radiance accepts commands in the 
format:"#NcommandCC<CR>", where N is a command count from 0-9 (10 just wraps back to 0), and 
CC is an 8 bit checksum of the previous chars in the command (i.e. "#0ZQS008E<CR>" is a correctly 
formatted command with a valid checksum). Acks ("!Y") are sent by the Radiance only when commands 
are received with matching checksums in this mode. The command count is included in the checksum 
but is not verified to be incrementing so it can be left unchanged from one command to the next if 
desired.  
The command is:   

 MENU → Other → RS-232 Setup→ Delimiters→ (Off, On, On with Ack/Nack)
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ASCII Command List 

Remote RS232-ASCII Description 

ON % Power on 

STBY $ Power to standby 

MENU M Activate menu 

EXIT X Exit. Often acts as a cancel key 

HELP U Displays on-screen help for highlighted menu item. 

CLR ! Force menu off (i.e. can use to assure menu is off for input selection) 

INPUT i Choose input (i.e. i2 for input 2 and i+2 for input 12) 

ZONE L Output zone select 

ALT # Alternate 

PREV P Display previous input 

PIP-OFF e PIP off 

PIP-SEL p PIP select 
PIP-
SWAP r PIP swap 
PIP-
MODE m PIP mode 

OK k Accept command 

OK <enter> Accept command (uses the PC "ENTER" keycode) 

< < Left arrow ("less-than" key on keyboard) 

> > Right arrow ("greater-than" key on keyboard) 

v v Down arrow (lower-case v, as in "vote") 

 ̂  ̂ Up arrow (shift 6 key on keyboard) 

0 0 Enter the digit 0 

1 1 Enter the digit 1 

2 2 Enter the digit 2 

3 3 Enter the digit 3 

4 4 Enter the digit 4 

5 5 Enter the digit 5 

6 6 Enter the digit 6 

7 7 Enter the digit 7 

8 8 Enter the digit 8 

9 9 Enter the digit 9 

+10 + Add 10 to the next digit entered 

NLS N Non Lineal Scaling 

4:3 n Input is 4:3 format. Use previous zoom setting. 

4:3NZ [ Input is 4:3 format. No zoom. 

LBOX l Input is 4:3 letterbox format. Use previous zoom setting. 

LBOXNZ ] Input is 4:3 letterbox format. No zoom 

16:9 w Enhanced for 16:9 televisions format. Use previous zoom setting. 

16:9NZ * Enhanced for 16:9 televisions format. No zoom. 

1.85 j Input is 1.85 format. Use previous zoom setting. 

1.85NZ / Input is 1.85 format. No zoom. 

2.35 W Input is 2.35 format. Use previous zoom setting. 

2.35NZ K Input is 2.35 format. No zoom. 

MEMA a Select MEMA 

MEMB b Select MEMB 
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Remote RS232-ASCII Description 

MEMC c Select MEMC 

MEMD d Select MEMD 

  g Onscreen messages on 

  s Onscreen messages off 

FREEZE z Freeze-frame. Any other character resumes 

480P A Select Vertical Resolution = 480p 

540P B Select Vertical Resolution = 540p 

600P C Select Vertical Resolution = 600p 

720P D Select Vertical Resolution = 720p 

768P E Select Vertical Resolution = 768p 

840P F Select Vertical Resolution = 840p 

1080P G Select Vertical Resolution = 1080p 

1080I I Select Vertical Resolution = 1080I 
ASPECT = Set Output aspect ratio (i.e. =178 <enter>, for 16:9 displays) 

 _  

The no-op character is ignored, between commands, by the RS232 
interface. The underscore character can be used inside a message 
command. 

  tXMM 

Test Pattern command: X is a letter 'a'-'p' corresponding to the 16 
available test patterns. MM: 0-10 corresponds to 10%-100% stepping by 
10%. MM: 11-20 corresponds to 5%-95% stepping by 10%. Sending 'X" 
will exit. Note: the “TxMM” test pattern rendering command is an older 
command and the letters used to render test patterns don’t match the 
letters returned by the newer “ZQ102” query command. 

  taMM Crosshatch 

  tbMM Overscan (always displayed as 100 IRE) 

  tcMM Contrast (always displayed as 100 IRE) 

  tdMM Every other Hline (always displayed as 100 IRE) 

  teMM Every other Vline (always displayed as 100 IRE) 

  tfMM Ramp (always displayed as 100 IRE) 

  tgMM White Window 

  thMM White Solid 

  tiMM 75% Colorbars (always displayed as 75 IRE) 

  tjMM Red Solid 

  tkMM Green Solid 

  tlMM Blue Solid 

  tmMM Yellow Solid 

  tnMM Cyan Solid 

  toMM Magenta Solid 

  tpMM Contrast2 (always displayed as 100 IRE) 

 tqMM Red Window 

 trMM Green Window 

 tsMM Blue Window 

 ttMM Yellow Window 

 tuMM Cyan Window 

 tvMM Magenta Window 

 tA Set Adjustable test pattern mode 

 tR Set Reference test pattern mode 

 ZBc  

Block character-- The character “c” will be displayed as a solid block “¦ ” 
in onscreen messages. The main usage is to display control settings 
such as a volume control. Also see command “ZTMxxxx”. 

  ZC Clear any onscreen message 
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Remote RS232-ASCII Description 

 ZD<0,1,2,3> 

Set Delimiters-- 0=off, 1=on, 2=on with ack/nack, 3=on with checksum 
and ack/nack. See page 2: “Optional start/end delimiters for RS232 
commands”. 

 ZE<0,1,2>  
Set Echo-- 0=echo off, 1=echo on (default), 2=echo off with status. See 
page 2: “Echo command”. 

 ZQI00  

Basic input info-- returns (logical input#1-18, input memory a-d, physical 
input #1-18). Example response: "!I00,1,A,1<CR><LF>" for logical input 
1, MemA, physical input 1 

 ZQI01 

Input video-- returns (0=none,1=video active,2=testpat active},  vert rate 
*100, horiz res, vert res, interlaced). Example response: 
"!I01,1,5992,720,480,1<CR><LF>"  for active 480i video 

 ZQI02 

Input pattern info-- returns ( {On=1,Off=0}, pattern group 'a'-'o', sub 
pattern #, IRE level 0-100, A/R for adjustable or reference patterns). 
Example response: "!I02,1,a,1,100,R<CR><LF>"  for overscan test 
pattern on and set to overscan at 100 IRE and reference levels. Note: 
the letters returned by the newer “ZQ102” query command don’t match 
the letters used in the older “TxMM” test pattern rendering command. 
 
“a,0”=Crosshatch, “a,1”=Overscan, “a,2”=AspectSquares,  
“b,0”=Contrast1, “b,2”=Contrast2,  
“c,0”=HLines,  “c,1”=VlLines,  
“d,0”=Ramp,  
“e,0”=GrayWindowMed, “e,1”=GrayWindowSm, “e,2”=GraySolid, 
“f,0”=100%ColorBars, “f,1”=75%ColorBars,  
“g,0”=RedWindowMed, “g,1”=RedWindowSm, “g,2”=RedSolid, 
“h,0”=GrnWindowMed, “h,1”=GrnWindowSm, “h,2”=GrnSolid, 
“i,0”=BluWindowMed, “i,1”=BluWindowSm, “i,2”=BluSolid,  
“j,0”=YelWindowMed, “j,1”=YelWindowSm, “j,2”=YelSolid, 
“k,0”=CynWindowMed, “k,1”=CynWindowSm, “k,2”=CynSolid, 
“l,0”=MagWindowMed, “l,1”=MagWindowSm, “l,2”=MagSolid. 
“m,0”=DesaturatdRedWinMed, “m,1”=DesaturatedRedWinSm, 
           ”m,2”=DesaturatedRedWinSolid 
“n,0”=DesaturatedGrnWinMed, “n,1”=DesaturatedGrnWinSm, 
            ”n,2”=DesaturatedGrnWinSolid 
“o,0”=DesaturatedBluWinMed, “o,1”=DesaturatedBluWinSm, 
             ”o,2”=DesaturatedBluWinSolid 

 ZQI03  

Output1 and Output2 config select for current input memory-- returns 
(Output1<0,1> disabled=0 enabled=1, Output2<0,1>, config select<0-
7>) Example response: “!I03,1,0,3” would mean out1 is enabled, out2 is 
disabled, using output config3 

 ZQI04 
Current input audio select-- XX=0-5 HDMI, 6-11coax, 12-13 optical, 14-
17 stereo 

 ZQI05 (Note 1) Current input black level--      returns -64 to 64> 

 ZQI06 (Note 1) Current input contrast level--  returns –127 to 127 

 ZQI07 (Note 1) Current input color format--    returns 0=auto, 1=Bt.601, 2=Bt.709 

 ZQI14 (Note 1) 
Current input YC delay-- returns (cr,cb)  -31 to 31, multiply value 
returned by 1/16 of a pixel. 

 ZQI15  
Current input deinterlacing mode-- returns 0 for “auto”, 1 for “film”, 2 for 
“video”. 

 ZQI16  

Current input vertical shift—returns (index,value). Index=0 is off, 
Index=1-15 is the index of current setting being used and value is the 
amount (-511-511).  

 ZQO02 

Output aspect-- returns (current output aspect, followed by 5 output 
aspects for input aspects 4:3,Letterbox,16:9,1.85,2.35) 110-250 
corresponds to 1.10 - 2.50 

 ZQO03  Output shrink-- returns (top,left,bottom,right) 000-255 pixels 

 ZQO04  Output gamma-- current range is 85-130, corresponding to .85 -1.30 

 ZQO15  
Output black and contrast-- returns (black,contrast), black is -64 to 64, 
contrast is -127 to 127 

 ZQO16 

Output mode name--  Names are same as seen in the menu under 
Output:Configs:ConfigX:Select Mode. Corresponds to the “ZY44” set 
output mode by name command. 
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 ZQO17 Output ctemp points-- returns number of ctemp points (2, 5, 11, 12, 21) 

 ZQO89 

Output color temp-- if using 12 pt returns (IRE point 12), If using 21 pt 
returns (IRE points 11-20), the value is in range 0-1000, corresponding 
to 0-100.0 (ZQO09 returns pts 0-10) 

 ZQO90 

Output color temp-- if using 12 pt returns (R point 12), If using 21 pt 
returns (R points 11-20), the value is in range 0-1000, corresponding to 
0-100.0 (ZQO09 returns pts 0-10) 

 ZQO91 

Output color temp-- if using 12 pt returns (G point 12), If using 21 pt 
returns (G points 11-20), the value is in range 0-1000, corresponding to 
0-100.0 (ZQO09 returns pts 0-10) 

 ZQO92 

Output color temp-- if using 12 pt returns (B point 12), If using 21 pt 
returns (B points 11-20), the value is in range 0-1000, corresponding to 
0-100.0 (ZQO09 returns pts 0-10) 

 ZQS00  Alive-- returns ("!S00,Ok<CR><LF>") if working 

 ZQS01  

Id-- returns (model name, software revision, model#, serial #) Example 
response: "!S01,RadianceXS,102308,1009,745<CR><LF>".  
Radiance XD model number is 1009, XE will be 1010 

 ZQS02  Power-- returns Off=“!S02,0<CR><LF>” ,On=“!S02,1<CR><LF>”  

 ZQS03  Zoom step%-- current values returned are 5,15 

 ZQS04  
Output trigger status for trigger 1,2- Returns 0 for low, 1 for high 
Note: NA on RadianceXS 

 ZQO00  

Basic output info-- returns (current output config 0-7, video on for out1, 
video on for out2, audio on for out1, audio on for out2). Example 
response: "!O00,1,1,0,1,1<CR><LF>"  output cfg = 1, video out1 is on, 
video out2 is off, audio out1 is on, audio out2 is on. 

 ZQO01  

Output mode-- returns (vertical rate * 100, horiz res, vert res, interlaced). 
Example response: "!O01,5994,1920,1080,0<CR><LF>" for a default 
1080p output mode 

 ZTMxxxx<CR> 

 
Print message on the screen-- M = '0' to ‘9’... '9' leaves message until 
"ZC" sent. 2 lines, 30 characters per line, legal characters '' through 'z' 
(0x20 - 0x7a in hex), a carriage return or '{' can be used to terminate 
message. ASCII extended characters set solid block for use as a volume 
bar. Also see command “ZBc”. 

  ZY0M<CR> 

 
Set zoom factor to M-- Where M can be 0-2 (or 0-7 if zoom is set for 5% 
steps) 

  ZY1MMM<CR> 

 
Set output aspect ratio to MMM for all input aspects--. Where the valid 
range is 110-250 which corresponds to 1.10 to 2.50. See “ZY45”. 

  ZY2MMMNNNOOOPPP<CR> 

 
Set output shrink parameters-- Where MMM=top, NNN=left, 
OOO=bottom, PPP=right edge. Range is 0-255 for each. 

 ZY3<1,2><H,L><CR> 

Sets trigger-- 1 or 2 either H=on or L=off. For exclusive RS-232 control 
of the trigger set the Radiance trigger menu to “Under RS232 control” 
(Menu, Other, Trigger Out, (Trigger1, Trigger2), Under RS232 control). 
Note: NA on RadianceXS 

 ZY40XXX<CR> 
Set output color mgmt gamma-- XXX =085-130 which corresponds to 
0.85 to 1.30 

 ZY43BLSVVV<CR> (Note 1) Set out black--                S=sign<+,->, VVV = value<000-064> 

 ZY43COSVVV<CR> (Note 1) Set out contrast--            S=sign<+,->, VVV = value<000-127> 

 ZY44<ModeName><CR> 

Sets up the output mode by name-- Names are same as seen in the 
menu under Output:Configs:ConfigX:Select Mode. Corresponds to the 
“ZQO16” output mode name command. 

 ZY45XMMM<CR> 

Sets output aspect to MMM for input aspect X-- X(0=4:3, 1=Letterbox 
2=16:9, 3=1.85, 4=2.35) MMM<110-250> which corresponds to 1.10 to 
2.50. See “ZY1MMM” command to set aspect ratio for all input aspects. 

 ZY46F<CR> 

Set output format-- F=0-3 (0=YCbCr422, 1=YCbCr444, 2=RGB-PC, 
3=RGB-Vid). 

 ZY503XYZ<CR> 
Set input memories output config select-- Enable Output1 X<0,1> 
disable=0 enable=1, Enable Output2 Y<0,1>, Output Config Z<0-7>. 
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When output is disabled it outputs 1080i blank video. 

 ZY504XX<CR> 

Set input audio select to XX-- 00-05 HDMI (only valid on HDMI inputs 
and must match the selected HDMI input) 06-11coax, 12-13 optical, 14-
17 stereo 

 ZY505SVVV<CR> (Note 1) Set input black level--        S=sign<+,-> VVV=value <000-064> 

 ZY506SVVV<CR> (Note 1) Set input contrast level--    S=sign<+,-> VVV=value <000-127> 

 ZY507X<CR> (Note 1) 
Set input color format-- 0=auto, 1=Bt.601, 2=Bt.709. SD inputs are fixed 
to Bt.601 and a setting of auto or Bt.709 is ignored. 

 ZY514SXXSYY<CR>(Note 1) 
Set input YC Delay-- S=Sign<+,->,XX=Cr delay <00-31> in 1/16 of a 
pixel, S=Sign<+,->, YY=Cb delay <00-31> 

 ZY515X<CR> Set input deinterlacing mode—0=”auto”, 1=”film”, 2=”video” 

 
ZY5160XX<CR> 
ZY5161XXSVVV<CR> 

Set input vertical shift. Can just switch which vertical shift setting is being 
used with “ZY5160XX” where XX=0-15 (0 is off, 1-15 would be a vertical 
shift setting). With “ZY5161XXSVVV” you select which shift setting to 
use (XX) and also set the value (S=sign<+,->,VVV=value <-511,511>)  

 ZY520X 

Toggle HDMI Hotplug-- useful to get sources to re-read EDID 
information and possibly change audio or video output formats. X =0-5 
corresponds to HDMI input 1-6, 7 corresponds to all HDMI inputs 

 ZY6SAVECONFIG<CR> Save configuration-- 

 ZY7M<0,1><CR> Menu position-- 0=default menu, 1=menu at top 

 ZY7TGSIII<CR> 

Test pattern command-- G=test pattern group 'a' - 'o', S=subpattern 
number, 0-n. Number of subpatterns depends on the group, III = IRE, 
000-100. Will round to nearest step of 5. This command matches the 
format of the test pattern status command and should be used instead of 
old “tXMM” command. 

 

(Note 1)  The current input setting is combined with the current output setting. The actual setting 
used is limited to the maximum range of the register. 

 



Section 9 – Command Interface 

RadianceXS  rev 11/17/10  43 

Section 10 – Specifications 

Input 
• 10 video inputs:  

o 4 HDMI 1.3, (480i to 1080p60) 
o 2 Component, SD/HD (480i to 1080i and PC up to 1280x1024 at 60 Hertz) 
o 2 SVideo (480i, 576i) 
o 2 Composite (480i, 576i) 

• 11 audio inputs:  
o 4 HDMI 1.3 
o 2 Analog Stereo 
o 2 Digital Optical 
o 3 Digital COAX 

• Automatic detection for NTSC, PAL and SECAM 
• Analog inputs support NTSC (M, Japan, 4.43), PAL (B, D, G, H, I, M, N, Nc)  

and SECAM (B, D, G, K K1, L). 
• Analog audio and video inputs, absolute maximum rating is ±1 volts, referenced to case 

Processing 
• 10-bit processing front-end with 12-bit calibration pipeline 
• Proprietary Lumagen “No-ring” ™ scaling 
• Optional support for HDMI 1.4 3D 
• Each input has 4 user configuration memories, with 8 resolution sub-memories for each 
• 2:2, 3:2 and 3:3 pull-down for SD/HD film sources  
• Per-pixel SD/HD video de-interlacing 
• Adaptive diagonal filtering 
• MPEG mosquito and block artifact reduction 
• Temporal noise reduction for SD/HD sources 
• User programmable non-linear-stretch (NLS) mode, 4:3 to 16:9 or 16:9/1.85 to 2.35 
• 4:3, LBOX, 16:9, 1.85, 2.35 and NLS input aspect ratios 
• Programmable output aspect ratio from 1.33 to 2.50 
• Support for anamorphic lenses 
• Extensive suite of test patterns 
• Parametric grayscale calibration, 2,5,10,11 or 21 point 
• Parametric Gamma calibration, 2,5,10,11 or 21 point 
• Programmable input/output color-space 
• Y/C-delay calibration 
• User-adjustable image enhancement  
• CUE and ICP filtering 
• Supports HDCP 

Output 
• 2 HDMI 1.3 outputs, 480p to 1080p and 1080i 
• Eight channel audio at 192 kHz 
• Supports DD True-HD™, and DTS Master Audio™ 
• Each HDMI output provides “stand-by” power to external device of +5V at 50 mA 
• One Digital COAX audio 

Miscellaneous 
• IR and RS232 control (See Tech Tip 11) 
• LVTTL IR format command input LVTTL IR format command input (See Tech Tip 9) 
• Universal Power Supply, INPUT: 100-240V at ~50/60Hz. OUTPUT: 12.0 VDC, 5.0A 
• Power consumption: 24 Watts 
• Optional rack mounting ears 

 


